Windows 3.1

Recording scssion

The Windows Recorder facility has nothing to do with video or sound; rather, for repetitive tasks,
its time-saving abilities could be invaluable. Panicos Georghiades and Gabriel Jacobs explain.

he computer is the ultimate
programmable automated
machine, and its keyboard and
mouse are multi-functional. The problem is
that we can end up with having to press
innumerable combinations of these
buttons whereas just one could do the job
of many. In other words, we could do with
a single piece of program code that
manipulates other programs: a computer
using a computer.

Such programs do exist and many are
free, like the macro recording facilities in
word processors. Windows has its own
under-used Recorder accessory. Despite
the camcorder icon for this accessory,
which to many users may be misleading,
this program has nothing to do with
recording video or sound (there’s a
separate Sound Recorder accessory).

The Recorder is not a full-blown facility
as found in Excel or Word for Windows: it
lacks a programming language. In other
words, you can’t set up a command script.
It merely records your moves and you
cannot subsequently edit the result, so if
you make a mistake you have no option but
to record again. What’s more, the Recorder
doesn’t accept any input at run time and
lacks decision-making capabilities.

The good news is that your Recorder
macros can span a number of Windows
applications simultaneously, so you can
copy data from one to another. And, a
macro recorded in one application can work
in another, provided its moves make sense.
So, if you find you’re constantly involved in
repetitive tasks, the Recorder can be a
time-saving tool, and despite the
restrictions we’ve already mentioned, the
uses to which it can be put are legion.

Recorder saves its macros in files with
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“letters”, where you keep personal details
and standard phrases you use in
correspondence such as “Yours sincerely”.
These can then be used in any Windows
text application: WordPerfect, Write,
Notepad. You're not restricted to the
macros you may have written in your most-
used word processor.

There’s no need to present a full-blown
tutorial on the Recorder here because the
manual is good enough. Instead, we've
provided some handy tips and examples.

The automated letter-writing macro

If you write letters, which are made up of
standard phrases, to different people you
can automate the process by having the
Windows Recorder type in the appropriate
one for you. Just select the ones you want:
1. Double-click on the camcorder icon and
from the Macro menu select Record.

2. In the Record Macro dialog box, type in a
name for your macro (Address, say) and a
shortcut key, perhaps A. (The Ctrl check box
will be crossed, so your shortcut key is in
fact CTRL A — see the Tips panel for the
reason why you should stick to CTRL.)

3. At the list box named Record Mouse,

select Ignore Mouse.

4. At the Playback To list box, select Any
Application.

5. If you wish, type in a description and click
on the Start button. The Recorder window
will minimise and start flashing.

6. Type in your Address with carriage
returns (CRs):

The Man with No Name <CR>

Clint Eastwood Estate <CR>

A Town called Hell <CR>

Wild West<CR>

7. Click on the minimised Recorder icon
and on the OK button to save the macro.
8. Select Record again and repeat the
above procedure for any other standard
phrases you use.

9. Finally, choose Save As and save all the
macros in a single file (PHRASES, say).

To use these, run Recorder and load
PHRASES.REC. From your word or text
processor, type the shortcut key for the
phrase you require, or double-click on the
name of the appropriate macro.

A Screensaver On macro
There are also cases where you would want
a single macro to be assigned to an icon so
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that it will execute when you double-click on
it: setting the screensavers on and off, say.

If your machine is used by different
people with their own preferences about
how Windows looks, you can expand this
macro to change sets of Control Panel
settings (wallpaper, screensavers, colours
and so on), create a macro for each user
and store them all in the same file, which
can be run from the Startup group. All you
do is select which user is on.

1. Double-click the camcorder icon and
from the Macro menu select Record.

2. The Record Macro dialog box appears.
Type in a name for your macro, say Screen
Saver On, and a shortcut key, say 1. (You'll
notice that the Ctrl check box is crossed, so
your shortcut key is CTRL 1) .

3. At the Record Mouse list box, select
Ignore Mouse. Type in a description, and
click the Start button. The Recorder window
will again minimise and start flashing.

4. Press: ALT F, then R. Type in
CONTROL.EXE and press <CR>. Now
press: ALT S/ D <the Tab key — 3 times>,
<Down/Up arrow to the select the
screensaver scheme you want>, <the Tab
key> 1 <CR> ALT + spacebar C.

5. Click on the minimised Recorder icon
and the OK button to save the macro.
Select Record again and repeat the above
procedure for Screensaver Off — you select
None as the screensaver scheme.

6. Choose Save As and save all the macros
in a single file (SCREEN, say).

To make these macros run
automatically, see the procedure outlined in
the main text (@bove) and replace
MYMACRO.REC with SCREEN.REC, and
the shortcut key with CTRL 1, or anything
else you want to use. To give a macro an
icon so that it can be run with a double
mouse-click, select New from the File menu
of the Program Manager, click on Program
[tem and at the text box reading Command
line, insert:

RECORDER.EXE MYMACRO.REC

where MYMACRO.REC is the file containing
your macro(s). This will load the macro file,
but won’t play it. To play it automatically,
your command line should read:
RECORDER.EXE -h ShortCutKey
MYMACRO.REC

Here, to start the macro, you have to use
the shortcut key pre-defined in your file, and
the following conventions must be followed:
ALT is represented by % / CTRL by A/
SHIFT by +. So the command line for a
macro starting with the shortcut key-

Tips for macro recording

m There’s no need to assign a name and a
shortcut key: either is adequate, but you
must define a shortcut key if you want to use
one.

m Although you’re allowed to use ALT as part
of your shortcut key combination, don’t.
You’re almost bound to run into conflict
problems because Windows and Windows
applications use it.

m |f you're preparing a macro to demonstrate
a piece of software or some method,
remember to select Recorded Speed as the
playback speed instead of the default Fast
option. Note that there’s also a Continuous
Loop option available which is useful for
continuously running presentations.

m Practice the moves first, and write them
down before recording.

m As far as possible, stick to keystroke
combinations only instead of mouse
movements and clicks: they present
problems because the screen positions are
also recorded, and opting for mouse co-
ordinates relative to the screen rather than
the window doesn’t necessarily help. The
only time you will need to use the mouse is if
you’re copying data or drawing graphics.

m Macros are transferable from one
computer to another but you’ll run into
trouble if the two machines use different
graphics resolutions or keyboard drivers.

combination CTRL F2, and stored in file
MYMACRO.REC will be:
RECORDER.EXE -h "“F2 MYMACRO.REC

Note that the above line implies that
MYMACRO.REC is stored in your Windows
directory; if not, you have to specify the
path. Therefore, if MYMACRO.REC is
stored in a directory called MACROS on
drive G, the above line would read:
RECORDER.EXE -h "“F2 C:\MACROS
\MYMACRO . REC

The default icon for macros is the
camcorder, but you can change that. There
are lots of macros you can design to do
many things. Windows Write, for instance,
can be enhanced with a macro to be used
for automating formatting. You can create
macros which combine a set of formatting
features like font size, style or indents to
create a selection of styles for headings and
paragraphs, so that a single mouse-click
does the job of five or six dialog boxes.
m We’'d be glad to hear from you if you've
thought of a really useful macro.
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If you have any queries or Win 3.1-related topics
to discuss, contact Panicos Georghiades and
Gabriel Jacobs at win3@pcw.co.uk.
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Windows 3.1

Lost ond font

Help! I've lost my fonts. Deleting fonts is a dangerous business — Panicos Georghiades and
Gabriel Jacobs tell you what you need to restore the status quo. Plus, a tip on Cardfile conversion.

aving been carried away with
your article about fonts in PCW
July, | removed all the fonts
except those | use. Big mistake! |
overlooked those that Windows holds for
Microsoft Works and Access, as well as for
its own use. Can you tell me what basic
fonts should be left in Windows\System?”
lan Shutes
ianshutes@enterprise.net
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We list here the fonts supplied with
Windows 3.1. They’re used for supporting
the system and Windows applications, for
DOS applications running in Windows and
data copied to the Clipboard from these
applications. As for Access and Works,
specific templates may use specific
TrueType fonts supplied with these
packages as extras. The system font files
for various screen resolutions are:
8514SYS.FON
EGASYS.FON
VGASYS. FON

OEM (Original Equipment Manufacturer)
font files, for various screen resolutions,
used for OEM text in the Clipboard Viewer
and as a character set for certain Windows
applications, are:
85140EM. FON
EGAOEM. FON
EGAOEM. FON
VGAOEM. FON

In addition, some variants of raster
screen fonts come with Windows, used for
printing text and graphics as bitmaps or
raster lines. The variants, each for a different
screen resolution, have one of the letters A
to F appended to the filename of the font.
Included with Windows 3.1 are B (EGA
display), E (VGA display) and F (8514
display). The fonts are:
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COURX . FON
SSERIFx.FON
SERIFx.FON
SMALLX . FON
where the X is a letter A to E. For instance,
SSERIFE.FON is the VGA variant of
Microsoft Sans Serif. Windows also comes
with three vector (fully scalable) font files:
ROMAN . FON
SCRIPT.FON
MODERN . FON

Most important of all, five TrueType fonts
are supplied with Windows (three of them
as families). Each font has (not shown here)
a file with a .FOT extension and a file with a
.TTF extension. Each filename for Arial,
Courier and Times New Roman, apart from
the regular font, is followed by BD for the
Bold version, | for the Italic version, and Bl
for the Bold ltalic version. For example, the
regular Arial filenames are ARIAL.FOT and
ARIAL TTF. Arial Bold ltalic requires
ARIALBI.FOT and ARIALBI.TTF.

The supplied TrueType font files are
ARIAL (Arial), COUR (Courier), TIMES
(Times New Roman), SYMBOL (Symbol)

Fig 1 Be careful not to delete fonts required by
system and Windows applications

and WINGDING (Wingding). Also to be
added are certain fonts used for displaying
non-Windows applications in a window:
APP850.FON DOSAPP . FON
CGA40850.FON CGA40WOA. FON
CGA80850. FON CGABOWOA. FON
EGA40850.FON EGA40WOA. FON
EGA80850.FON EGA8OWOA. FON
HERC850.FON HERCWOA . FON

VGA850.FON VGA860.FON
VGA861.FON VGA863.FON
VGA865.FON

Since you have deleted many of the
supplied fonts and we don’t know anything
about your requirements, it would probably
be best to re-install all the standard
Windows fonts we’ve mentioned.

MPEG empathy
“How can | tell if | have MPEG capability?
I’m sure | do, but | don’t think | have the
software and/or drivers to view the files.”
Andy Davis
alchemist@emarkt.com

MPEG playback capability, which enables
you to view full-screen full-motion video files
including Video CDs (commercial movies
and pop videos) comes in three flavours:

1. Software-only utilities.

2. A chip on an S-VGA graphics card.

3. A separate MPEG card, sometimes
attached to the graphics card with a cable,
or as a daughterboard.

If you do have the drivers installed you’ll
see the relevant lines in the Drivers section
of the Control Panel. MPEG is installed as
an MCI (Media Control Interface) device, like
sound cards and CD-audio, MIDI, animation
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Cardfile conversion

easily without them:

Printers icon in the Control Panel.

button, and select No Page Break.
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One use of the Print to File facility is to convert certain non-ASCI| file formats to ASCII for
importing into other applications; an example being Windows Cardfile files. A number of utilities
are available in the public domain for converting Cardfile files to ASCII, but the job can be done

1. Install the Generic/Text Only printer driver and configure it to Print to File. Do this from the

2. Start Cardfile and load the file you want to convert. Select Print Setup from the File menu, and
in the dialog box select Specific Printer, then the Generic/Text Only driver. Click on the Options

3. Go to the File menu, select Page Setup and clear the Header and Footer boxes. Close dialog
boxes and select Print All from the File menu. Enter the path and filename with, say, a .TXT extension.
4. You can now load this text file into a word processor, although you may find that you have to
do some cleaning up, such as getting rid of blank lines.
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Fig 2 Checking for MPEG drivers

and other multimedia elements (Fig 2).

If the drivers aren’t installed, have a look
on your hard disk for any directories
containing drivers and documentation
about the card. The software may be on the
hard disk, even though it’s not installed.
Failing that, open your PC and have a look
at the hardware. Check your graphics card
and any card next to it: every adapter card
has a label printed on its PCB. Also, have a
look at the names of the chips on the cards:
many MPEG cards use a C-Cube chip.
There are only about ten makes of MPEG
card sold in the UK, so you should be able
to identify whether you have one or not.

Changing names

“In May’s PCW, in the Hands On section,

Tim Nott wrote about how to change the

username and company name of a PC.

What is the Win 3.7 version of this solution?”
globalte@users.AfricaOnline.Co.Ke

in SERIALNO.INI (Windows directory) in
Workgroups 3.11. The latter is an editable
file, so if you have Windows for
Workgroups 3.11, use Notepad or some
other text editor to put in the name(s) you
want, and re-start Windows. Simple!
Not so simple with the other versions
mentioned above, though. But there is an
undocumented and unsupported method
(with a warning from Microsoft that it
doesn’t encourage its use). So if you're
using Windows 3.1, 3.11, or Windows for
Workgroups 3.1, here’s the answer, but on
your own head be it if you decide to use it.
1. Choose Run in the File menu of the
Program Manager and enter SETUP /F as
the command line, then OK.
2. Enter the new name and company name
and click Continue. Then confirm.
3. The Setup Options screen will be
displayed: again click Continue. Same with
the Install Components screen, and if the
Swap File screen appears, do the same.
4. You'll be asked to insert a Windows disk
in drive A:. Click on the Exit Setup button
and confirm the exit. Exit Windows, and
when you re-start, the new name and
company name should be displayed. We
have tried this on some machines with no
problem, but we take no responsibility.

When Windows is first installed, you’re
asked for your name and company. This
data is stored in the file USER.EXE
(Windows/System directory) in Win 3.1,
3.11 and Windows for Workgroups 3.1, but

POW conest

If you have any queries or Win 3.1-related topics
to discuss, contact Panicos Georghiades and
Gabriel Jacobs at Win3@pcw.co.uk.
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Windows 3.1

Hands off my PC!

Are pesky people doing things to your desktop? Panicos Georghiades and Gabriel Jacobs
unlock the secrets of security using progman.ini, and release a secure screensaver tip, too.

his month, among the letters we
have received, we return to the
perennial cry of “Who's been
messing with my machine?”

Keeping it in the family
Q. “I need some help — someone in my
family keeps mucking up my desktop. At the
moment | have got my computer asking for
the first letter of my first name, then copying
the *.GRP files and the *.INI files from the
users\glenn directory to the Windows
directory. Is there an easy way to stop
people doing this?”
Glenn Moseley

moseleyg@usa.net
A. Someone in your family has created
directories which hold Windows
configurations for individual users and which
are initiated before you start Windows.
Provided these are updated when you exit
Windows and that your machine doesn’t
suffer from crashes, there’s no harm done.
And, of course, this does solve the problem
of different users using the same machine
and having different preferences settings.

If you don’t want others to use your
machine, use your hardware key, if you
have one, to lock it up. We suggest a
password method in the screensavers
section later on in this column, but if your
mystery family member is clever enough to
have thought of the method you’ve
described above, only a physical lock may
stop the perpetrator.

Getting the boot

Q. “Having recently decided to use a
multiple boot configuration | noticed, in your
March column, an item about installing
Windows 3.1 and Windows 95 on the same
machine and it would automatically start
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into Windows 95. | run most programs
through Windows 3.1, is there any way to
boot into DOS/Windows 3.1?”
lan McDougall-Ryan

balls@mail.zynet.co.uk
A. You need to edit the hidden and read-
only system file MSDOS.SYS, found in the
root directory of your boot drive, and add
the line
BootWin=0
in the [Options] section. After you’ve done
that, your machine will boot into MSDOS by
default instead of into Windows 95.
Pressing F4 just before the “Starting
MS-DOS” message at bootup will start
Windows 95. Please use a text editor (such
as Notepad) to edit MSDOS.SYS. Be very
careful and remember to revert its attributes
back to hidden and read-only after you've
edited it. In addition, do not delete all those
unnecessary-looking lines full of “x”s at the
end of the file: they are needed.

Wild filed

Q."In your Windows 3.1 column in the June
issue of PCW, you mentioned cutting and
pasting the filename in File Manager’s
Rename dialog box. As | am sure you know,
you can also use wildcards. In the To: box
you can enter *.bak, for instance, to change
Jjust the extension of the file in the From:
box. In fact, you can rename multiple files in
this way, and you do not need to select
them first.

For example, in the From: box, type in
\chk*.* and in the To: box enter \abc*.*
(should you, for some reason, want to
change the first three characters of
Checkdisk’s multiple files in the root
directory!).”

Steve Rainey
UnisoftComputers@compuserve.com

House-train a screensaver

Screensavers, originally designed to save
our monitors from burning out, are
nowadays used just as much for adding
user individuality to machines as for
preventing others from accessing machines
when you are not around. But a
screensaver, however cute and harmless it
may appear, is yet another program running
in the background along with your main
applications, doing its bit to slow your
machine down or popping up at times
when you wished you’d never installed it in
the first place.

The solution is to invoke it only when you
choose - if, say, you are planning to be
away from your desk for a considerable
length of time. You can do this by assigning
Program Manager icons and/or shortcut
keys to the screensavers of your choice:

1. Using Notepad (or any other text editor),
change the line in the win.ini file that reads
Programs com exe bat pif

to

Programs com exe bat pif scr

Then exit and restart Windows, so that this
can take effect. To add a screensaver icon
to an Application Group: from the Program
Manager’s File menu, select New, then click
on the New Program ltem radio button,
then on OK. Type a description into the
Description box and the command line in
the Command Line box.

Valid command lines for the
screensavers in Windows 3.1 are:

« SCRSAVE.SCR for a Blank Screen

o SSFLYWIN.SCR for Flying Windows

« SSMARQUE.SCR for the Marquee

o SSMYST.SCR for Mystify

« SSSTARS.SCR for the Starfield
Simulation

...or any other .SCR files you may have.

You can also assign a shortcut key in the
Shortcut Key text box, by pressing the key
of your choice.

Before enabling the screensaver, it's a
good idea to configure its options. To do
this, press the shortcut key or double-click
the screensaver’s icon and make changes
to the dialog box which appears. Here, you
can also add a password.

Up to this point you won’t be able to
start the screensaver. To be able to start it
by selecting the shortcut key or clicking on
its icon you need to add the /S switch to its
command line. To do this, select the
screensaver icon, then choose Properties
from the File menu. On the command line,
add the /S switch. For example, enter the
following in the Command Line text box:
SSTARS.SCR /S

The screensaver program icon will now
behave as any other program icon. It will
start the screensaver when you double-click
on it — handy if the boss walks in when
you’re playing Solitaire.

This will also provide an extra level of
security when starting Windows. By giving
the screensaver a password, then copying
the screensaver into the Startup Group, it
will start every time Windows starts, and
no-one else will be able to use your
Windows installation just by typing Win,
unless they know the password (see
adjacent panel).

Security using progman.ini

Being 100 percent sure that the subject of
machine security will crop up repeatedly,
we offer here a few more restrictions you
can apply, this time by using the
progman.ini file. Progman.ini is Program
Manager’s initialisation file. In essence, its
purpose is to contain information which tells
Windows what should appear in the
Program Manager window and how these
things should behave.

Generally speaking, settings in
progman.ini are automatically updated by
Windows when you create groups and
make certain changes. But it’s possible to
make changes to progman.ini using a text
editor like Notepad. For instance, you may
wish to add a [restrictions] section to the
usual [settings] and [groups] sections.

The [restrictions] section consists of
NoRun=
NoClose=
NoSaveSettings=
NoFileMenu=
EditLevel=

Windows 3.1

Set a secure screensaver

[ ]r
Description:
Command Line:
Working Directory:
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.SCR extension to
the Programs= line
in the Win.INI and
re-started Windows,
add your
screensaver as a
New Program item in
Program Manager

2. Double-click on the
screensaver icon and
change its options

3. Add a password

4. Click on the
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add the /s to the
command line in its
Program Manager File
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HELP help

2. Click on Edit, then select Annotate.

the screen.

5. Click on Delete to remove the comment.

File Edit

To add your own comments to Help screens:
1. Go into Help and to the area in which you would like to add comments.

Bookmark Help

3. Enter your text, and click on Save. You will notice that a paper-clip icon now appears on

4. When you click on this paper-clip, a pop-up window displays your text.

Notepad Helpr

Euntentsl Search I Back I History E

Contents for Notepad Help

inclows Motepad 5 a text editor that v
ALUTOEXEC BAT file.

Tolearn how to use Help, press F1

® NoRun=1 will disable (dim out) the Run
command on the File menu so a user won'’t
be able to run applications from Program
Manager unless the applications are set up
as icons in a group. This prevents
unauthorised use of certain applications.

= NoClose=1 disables the Exit Windows
command on the File menu, so the user will
be unable to leave the Program Manager
via either the File menu or the Control menu
(the Exit Windows and Close commands
will be dimmed), or by using Alt + F4.

m NoSaveSettings=1 prevents the current
settings being saved on leaving Windows,
by disabling the Save Settings on the Exit
command in the Options menu. It overrides
the SaveSettings= entry in the [settings]
section of progman.ini: useful when you've
defined the settings you need and don’t

want anyone to mess them up permanently.

m NoFileMenu=1 removes the File menu
from Program Manager (disabling New and
Delete operations, in particular). But a user
can still run applications with icons in
groups. And unless you've disabled the Exit
Windows command, a user can still leave
Windows via the Control menu or Alt + F4.
m EditLevel= followed by a number
between 0 and 4 sets certain restrictions
affecting the level of privilege applicable to
making changes to the Program Manager.
m 0 allows a user to make any change

(the default).

m 1 prevents anyone from creating, deleting
or renaming groups. The New, Move, Copy
and Delete commands on the File menu are
unavailable when a group is selected and
this can therefore be used in conjunction
with the NoFileMenu=1 entry.
m 2 sets all restrictions in level 1 and
prevents the creation or deletion of program
items. The File menu’s New, Move, Copy
and Delete commands are unavailable.
m 3 sets all restrictions in level 2 and
prevents anyone from changing command
lines for program items. The text in the
Command Line box in the Properties dialog
box cannot be changed.
m 4 sets all the above restrictions and
prevents people from changing any
program item information. None of the
areas in the Properties dialog box (which
will all be dimmed) can be changed.
m To change your restriction settings,
simply remove the entry concerned or set
the value to O.

But what’s to stop a user getting into
progman.ini and altering the settings to
remove restrictions? That’s another story!

POW coneet

If you have any queries or Win 3.1-related topics
to discuss, contact Panicos Georghiades and
Gabriel Jacobs at Win3@pcw.co.uk.




Windows 3.1

What a performance

Panicos Georghiades and Gabriel Jacobs investigate SmartDrive, which is installed on your
machine but uses some of your RAM. Learn how to alter settings to improve performance.

here are many things you can do
to your machine to increase its
performance: get more RAM, get

a larger and faster hard disk, get a faster
graphics card, and so on. Of course, they
all cost money. The cheapest and most
effective option is to upgrade the RAM
(12Mb is now our recommended minimum).
But there are other things you can do
which don’t involve buying anything, like
taking a good look at how your machine runs
and making a few changes to optimise its
performance. Your machine is a team rather
than a single worker, and the team needs to

be co-ordinated. Think of it as handling the
queues at a supermarket, with ordinary
checkouts, wide checkouts, checkouts for
eight items or fewer, and so on.

While the performance of MSDOS
programs relies mostly on how much free
memory is available below 640Kb,
Windows 3.x performance relies on the first
few free megabytes of available extended
memory, above what is required for
Windows itself (a good average estimate to
work with is about 3Mb).

Once Windows runs out of extended
memory it starts using the hard disk to store

= About Program Manager

Microsoft Windows Program Manager

Yersion 3.1

i Copynght © 1985-1992 Microsoft Corp.

386 Enhanced Mode

Memorny:

Syztem RBesources:

Yergion 3.1

WIHDOWS.

I Copyright @ 1385-1992 Microsoft Corp.

27.956 KB Free
81% Free

= About Program Manager

Microzoft Windows Program Manager

By checking memory
beforehand and while
an application is

386 Enhanced Mode
Memory:
System Resources:

26.232 KB Free
55% Free

running you can
estimate how much
memory it uses
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temporary files, and hard disk performance
can be between ten and thirty times slower
than that of RAM. A PC fitted with 8Mb of
RAM can be as slow as a tortoise, while the
same PC with 12Mb of RAM can run as
smoothly as if it had 32Mb. It all depends on
whether the additional 4Mb has made the
difference between swapping to hard disk
or working in RAM alone.

Smart move

When your machine reads and writes data to
the hard disk, it uses a program called
SmartDrive (smartdrv.exe) to hold information
in memory (in a so-called disk cache) so
larger chunks of data are being manipulated
at a time and fewer mechanical trips have to
be made by the hard disk heads to the
drive’s magnetic material. If you can carry
more things with you, you make fewer trips
and your work is done more quickly.

SmartDrive is installed by default on your
machine. It uses some of your RAM and
you can alter the default settings to make
things run more smoothly. On an 8Mb
machine SmartDrive takes up 2Mb. The first
megabyte of your RAM isn’t available to
your Windows programs either, since
640Kb is taken by MSDOS and some other
bits and bobs like expansion boards (video
cards, sound cards). Add in the 3Mb
Windows itself needs and you're left with
only 2Mb for your programs.

Many programs require more than 2Mb
of RAM, and in these cases decreasing the
amount of RAM used by SmartDrive from
2Mb to 1Mb can decrease, or even
eliminate, disk swapping.

It’s up to you to investigate how much
RAM your individual programs use. Using
Program Manager’s Help and About menu
option, check the amount of RAM you have

MA

=2 =R

available before you start a program, then
after you've started it and loaded a file, and
subtract one value from the other to get the
memory used by a particular program. Your
aim is to fit that amount of memory within
the RAM of your machine.

It may be evident at this stage that your
programs need a lot of RAM (say, more than
2Mb or 3Mb) and that you do need to
upgrade your RAM by buying more chips.
To find the physical memory available in
your machine and how it’s allocated, type:
mem/c
from the DOS prompt, when you’re not
running Windows, not from the DOS
prompt within Windows. And if you type:

Windows 3.1

iy Ry
iy Ry

=
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mem/c >pcw.txt
the information will be stored in a file called
pcw.txt so that you can do your calculations
while reading this from Notepad instead of
having the information flash up on-screen.

You'll now see how much RAM is free
after loading MSDOS and SmartDrive.
Subtract from this the 3Mb Windows will
take up and you’ll be left with the amount
your programs can use. If they can fit within
that amount, there won’t be much hard-
disk swapping — you'll be able to see and
hear whether this is going on anyway.

To change the values used by
SmartDrive, while still at the DOS prompt go
to the DOS directory (cd \dos) and type

Help. Follow the
= Calculator * | instructions and

Typing mem/c gives
you a rundown of how
your memory is used
under MDDOS

those of InitCacheSize
and WinCacheSize.

InitCacheSize sets
the size (in kilobytes) of
the cache when

499 SmartDrive starts

(before Windows is
loaded). The larger the
cache, the less often
data needs to be read

from the disk. If you don’t specify a value,

SmartDrive will set one according to the

amount of memory your machine has.

WinCacheSize specifies (in kilobytes)
how much the cache size will be reduced to
allow for Windows itself (when you exit
Windows, it returns to its initial size). The
default value depends on how much
available memory there is, but if you specify
a value smaller than that allocated to
WinCacheSize, InitCacheSize will be set to
the same size as WinCacheSize.

If you’re not running any DOS programs
which require extended memory, both
these values can be equal. We recommend
a larger SmartDrive value if you think your
hard disk is slow, and vice-versa. However,
these values must be relative to the total

B =
g
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two values of most  and no more than 25 percent of your total
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Windows 3.1

DLL dramas

Q. "I would appreciate your guidance on why DLLs seem to cause problems in Windows.

I recently had to reinstall Word on a laptop. All seemed fine until | ran the application. At 9.30pm the
only help I could think of was the Microsoft support desk in Canada! They very quickly identified the
problem and helped me to edit a couple of DLL files before reinstalling Word again. This seemed to

Chris Kushner 100634.75@compuserve.com

called at the time.

solve the problem but | didn’t get round to asking for an explanation. Can you assist?”

A. DLLs (Dynamic Link Libraries) themselves generally don’t cause problems, but they appear
to because when errors are reported on the screen they refer to the DLL which was being

DLLs are executable files that allow Windows applications to share resources. So, as their
name suggests, they can for example link applications so that when one is updated, the other
application takes account of the update. They’re often to be found in the Windows or
Windows\System directories, but can also reside elsewhere. They usually have a .DLL
extension, but some have .EXE and other extensions.

If an application is missing one of its DLL files, an appropriate and quite commonly seen
error message will appear: “Can’t find ....” (make sure that the DLL file is in the correct
directory). If an application is started with an outdated DLL file, the error message “Call to
undefined dynalink” will be displayed, and that may well be the error message you got. We
presume that the Canadians told you how to update the files.

was not found.

= Microsoft Word

“ord cannot open the YWord help file because WORDHELP.DLL

But there are no hard and fast rules. Play
within those two limits and see if you can
improve the performance by cutting down
on disk swapping. Note that Windows for
Workgroups 32-bit File Access replaces
the functionality offered by SmartDrive.
Cacheing is automatically disabled for
drives using 32-bit File Access and its
memory use is reduced to 128Kb. You
still need to use it, however, for cacheing
CD-ROM drives.

[t’s important you use the latest version
of SmartDrive available to you, as there can
be enhancements you require. You can
check which version you have by typing:
smartdrv /s

Version 2.1 shipped with MSDOS 4.01,
version 3.0 with Windows 3.0 and Windows
3.0a. Version 3.13 shipped with MSDOS
versions 5.0 and 5.0a, and Version 4.0
shipped with Windows 3.1 and 3.11.

Version 4.1 came with MSDOS 6.0 and
included support for DoubleSpace. Version
4.2 was available through online services
only and included a switch to clear the
cache. The latest versions are 5.0 which
shipped with MSDOS 6.20 and 6.21 and
Windows for Workgroups 3.11 (the first
version to support cacheing for CD-ROM

drives) and 5.01 which shipped with
MSDOS 6.22, fixed problems with Kodak
Photo CDs and included support for
DriveSpace disks.

It all adds up to a new Calculator
On this month’s CD-ROM and floppy disk
we distribute a new version of the Windows
Calculator, released by Microsoft, which
fixes a bug that occurs during subtraction of
decimal numbers and also makes the
calculator behave more like a handheld one.
The bugged version comes with Windows
3.1 and 3.11. Try 25.22 minus 25.21. You'll
get 0.00, 0.0099999999, 0.010000001 or
0.0000, rather than the correct answer of
0.01. Try also (1/3 + 10 - 10) x 3. You'll get
1.0 not 0.9999 which is what you would get
on a handheld calculator. This is due to the
fact that significant digits are lost by adding
and subtracting 10.

See this month’s disc for instructions on
how to install the new Windows Calculator.

If you have any queries or Win 3.1-related topics
to discuss, contact Panicos Georghiades and
Gabriel Jacobs at Win3@pcw.co.uk.
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Font memories

It’s not goodbye but au revoir to too many TrueType files — they can slow things down.
Panicos Georghiades and Gabriel Jacobs show you how to group fonts for specific jobs.

indows, and most of its
W applications, copy and store
TrueType font files to the

Windows\System subdirectory. But having
lots of fonts installed (more than 100, say)
can slow things down. So, it is a good idea
to keep groups of fonts dedicated to
different jobs in separate directories, and to
edit the [Fonts] section of your win.ini file to
keep only those fonts you need for a
particular job, by adding or subtracting
groups of entries.

Suppose you want to manage three
groups of fonts: one for everyday use, the
other two for projects
on which you work
only occasionally.

Bzalalled fonda:
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Remove fonts but do not
delete them from the disk
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Using an editor such as
Notepad (run two
instances) you can cut out
and save to two separate
files (say, project1.txt and
project2.txt) the group of
entries referring to the fonts

in the two different

directories. This il leave

your win.ini with only the

Keep the everyday Are you sure you want to remove the AmericanUncD fonts for normal use. Each
, [TrueType] font? )

ones in the time you want to use the

Windows\System [] Delete Font File From Disk special fonts, all you need

subdirectory, create

do is edit win.ini and paste

two other directories

| [vestoan]| | mo

I | Cancel I

in the lines you have

(for instance, Project1
and Project2) and
install the fonts as necessary.

To move the currently installed TrueType
fonts to a directory other than the default
Windows\System subdirectory, open the
Fonts icon in the Control Panel. Select all
the TrueType fonts you want to move and
then choose the Remove button.

The Remove Font window will ask for
confirmation about deleting each TrueType
font. Make sure that the Delete Font File
From Disk check box is not checked, and
then choose the Yes button — in other
words, remove the fonts from the
installation, but not from the hard disk
(Figs 1 &2).

Next, from File Manager move all the
TTF files, of those fonts you want moved,
to the two directories (Project1 and
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Project?). Restart Windows, and from the
Fonts icon in Control Panel choose the Add
button. Specify the c:\project1 directory
from the bottom of the Add Fonts dialogue
box. Windows will begin retrieving all the
font names from that directory (Fig 3).

Disable the Copy Fonts to Windows
Directory option by clearing the check box
at the bottom of the Add Fonts dialog box,
choose the Select All button, then OK. Do
the same for the Project2 directory fonts
and restart Windows.

The [Fonts] section in your win.ini will still
contain entries which will refer to .FOT font
files in the Windows\System subdirectory,
even though the .TTF files (the largest in
size) are now in the Project1 and Project2
directories.

previously cut out.

Question time

Q. “Is there definitive literature on Windows
for Workgroups 3.11 that explains the
meaning of all valid entries in the system.ini
and win.ini files, the relationship of these
files and their entries in the registry and the
software that may have caused the entries?
| ask this with a view to removing any which
are not required.

“In my win.ini file | have the title
[wt4gpi8sb6bz]. This precedes a selection
of font types which are repeated in the
section titled [fonts]. In my system.ini file
under [386ENH)] | have the following three
entries:

COM1AUTOASSIGN=
COM2AUTOASSIGN=
LPT1AUTOASSIGN=

[ e = r—
hegl Nparsded W Bold {1oml =l
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Windows 3.1

= The COM1AutoAssign= and
COM2AuUtoAssign= lines indicate
how Windows will treat requests for

[l e 8 I ol oo [ o =
- Tmarll . .
ol e :! st | | 1o yse of your communications
L]

b | ports by more than one application if

one of them is a non-Windows
application.

A value of O means that any
application can use the port at any
time. A value of -1 means you will get

Fig 3 Re-install the fonts but do not copy them to the

Windows directory

“What are the valid parameters?”
CA Hewitt
cc@dartnet.co.uk

A. The [wt4gpi8s56bz] section in your
win.ini is the remainder of an aborted or
failed upgrade session.

During an upgrade session (say from
Windows 3.0 to 3.1 or 3.11) the first part of
the Windows Setup disables certain
Windows components: namely all fonts
except the system, fixed pitch, and OEM
fonts, the Shell (Program Manager, Norton
Desktop for Windows, and so on), the
desktop bitmap, screensavers, Task
Manager and installable drivers loaded
through the Drivers= line in the system.ini
file. These components are to be replaced
by the new version’s components so that
they don’t interfere with the upgrade
process.

If the Setup process is interrupted before
the Windows graphical user interface mode
portion has been completed, some or all of
the above items may not be properly re-
enabled. Fonts are disabled by renaming
the [Fonts] section in the win.ini file to
[wt4gpi8s56bz].

Setup can encounter problems with re-
enabling the old fonts if the system memory
is very low or if two aborted installations
have occurred. If there is a problem, Setup
will display a message box telling you that
trouble was encountered when restoring
the previously installed fonts and that the
[Fonts] and [wt4gpi8s56bz] sections must
be merged by hand. So to do this:

1. Open win.ini using Notepad.

2. Delete any line from the [wt4gpi8s56bz]
section that is duplicated in the [Fonts]
section.

3. Append the contents of the
[wt4gpi8sb6bz] section to the [Fonts]
section.

4. Delete the [wt4gpi8s56bz] section.

a message asking you which
application should be given control of
the port.

The value of a positive number up
to 1,000 represents the number of seconds
after an application stops using the port
before another application can use it (the

Calendar tricks

Many people use Windows Calendar as
a simple alternative to Lotus Organizer
and its ilk. Unfortunately, it is very
limited. For example, it will not allow
you to print the Month View grid.
However, it is possible do this by
pressing Alt +PtrScr to capture the grid
to the Clipboard, opening Paintbrush or
any similar program, pasting the
picture, and printing it (Figs 4 & 5). Or,
Calendar will print only appointment
times if there’s an entry. So, to print
blank entries, simply enter a space on
the relevant time line(s). By the way, put
Calendar first in the Startup group, and
you see immediately what you’ve got on
that day as you boot up.

— Calendar - WORK.CAL BB

File Edit Yiew Show Alarm Options Help

1:32 Monday, 07 April 1997
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To print the month view of the 3

paste into Paintbrush
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Windows 3.1

Sound Recorder

Sound Recorder is a free Windows accessory for playing, editing and recording sound files,
although for recording you need a sound card and device drivers (to be installed in the Drivers
section of the Control Panel). It’s designed for small voice message files you would usually
attach to documents, as opposed to long pieces of music. For this reason, it has a maximum
default recording time of 60 seconds, but you can increase this time using this technique:
Record for the 60-second duration and Save As using any name, say “empty.wav”. Next,

choose Insert
File from the
Edit menu, and
select
empty.wav.
This increases
the recording
duration to 120
seconds. You
can repeat the
process as
many times as
you like, to
increase the
recording time,
until there’s
not enough

memory to

continue.

default is 2). To change a value, use the 386
Enhanced icon in the Control Panel.

The LPT1AutoAssign= entry is for your
printer port and applies only to Windows
3.0. As in your case, although it may still
appear in the system.ini after an upgrade, it
will have no effect.

Template time

“Regarding your ‘Step-by-Step Guide to
creating Write Templates’ [PCW, Aprill:
Although you are correct about using
templates — and also probably following
Microsoft’s ‘right way to do things’ — when
creating templates from Word or any other
application, you can get away with just
putting the path and filename of the
template. Provided the file type is registered
in File Manager, the relevant application will
automatically be launched.

“I know this saves very little time
compared with using a template but I had
never thought of doing it the way you
suggested. However, doing it in the way |
have mentioned above has never been any
trouble to me. Well, it takes different
strokes, doesn't it?”

Justin
justinc@j-catter.demon.co.uk

Yes, this will work fine for the example we
gave about using templates with Windows
Write (as well as with lots of other

programs). But be careful with templates
that involve file types which can be
associated with different programs; usually
images (BMP, PCX etc. and files like TXT
and DOC). New applications you install
have a tendency to associate files to
themselves.

Quick switch

“Having read your column about booting
Windows 95 and MSDOS off the same hard
drive [PCW, March], | thought | should
mention that there is an easier way to
switch back to DOS on booting.

“In your article, you mentioned pressing
F8, then going to option 8. Instead of
pressing F8, try pressing F4 and it will
perform these two steps in one.”

Chris Beaumont
cbeaumont@compuserve.com

Thanks, Chris. This undocumented option is
what was used in the beta release of
Windows 95 and it still works, provided you
don’t want to access any of the additional
Start options available with F8.

If you have any queries or Win3.1-related topics to
discuss, contact Panicos Georghiades and
Gabriel Jacobs at Win3@pcw.vnu.co.uk.
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All that glitters...

Even if you upgrade your RAM, you may still get “low memory” messages; it’s the first
megabyte which sets the gold standard. Panicos Georghiades and Gabriel Jacobs explain.

ur March column,

which dealt with

installing Windows

95 and Windows 3.x/DOS on

| [

the same machine, struck a

chord with many readers. We
have been fairly inundated
with queries about specifics,
S0 here is a selection.

Q. “Your article encouraged
me to try the Win95/3.x/DOS
combination. As my present

setup already has a multi-
config start-up menu, I'd like
to check whether or not this
may cause problems? | hope
it will be straightforward and
that | can continue to enjoy
multi-choice in DOS.”

James McFarlane
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j.mcfarlane@uea.ac.uk

A. There will be no problems Fig 1 The size of the opening window of some applications depends on available resources. As resources get

with your present DOS
multiple-boot configuration
menu. Since this is part of your DOS
config.sys and autoexec.bat setup, it will
come into effect only after you have
selected to start with DOS instead of
Windows 95.

Q. “Having installed Windows 3.11 and
Windows 95 onto the same hard drive in
directories Win3.1 and Win95, is it
necessary to load software into
C\win95\application or C\win371\
application, or do you just load them into
C\application?”
John Wright

john_wright@compuserve.com
A. As we said in the article, only a few
simple programs can be run from both 3.1

244 * Personal Computer World ¢ June 1997

and 95 installations: those that don’t, keep
settings in the Windows INI files, and don’t
have their own INI files in the Windows
directories. All the others must be installed
twice; once for 3.1 and again for 95.

We don’t recommend that you run
programs installed under Win3.1 in Win95
or vice-versa. The idea is to use 3.1 for
those programs that can’t be run under
Win95, either because they do something
specific or incompatible, or because they
use hardware peripherals for which you
don’t have 32-bit 95 drivers. Anyway, if a
program runs OK in Win95, why run it under
Windows 3.17?

To avoid problems, think of the two
installations as two sides of a coin which

less, so does the size of the window [see James Thompson’s letter, overleaf]

should never interfere with one another. The
straight answer in your case is that you
need to keep both application directories
separate.

Q. “I'm using Win3.1 but | also want to
use Win95, and having read your article,
| want to attempt the dual operating
system. However, I've managed to get
myself Win95 OEM, and was wondering
if it is still OK to load it together with
Win3.1. I understand that the OEM version
handles FAT32, and | am not sure if it will
still be safe.”
Panos Panayides

PAN4DEM@aol.com

A. You can't install both operating systems

using the method we described if you have
the OEM version that uses FAT32 (File
Allocation Table), otherwise known as the
OSR2 version. Microsoft technical support
says that you need a fix program which you
can get from them.

Q. “I'm a long-time PCW subscriber, still on
DQOS 6 and Windows 3.1. Could you please
tell me how to ensure that an application
always starts in a maximised window?
Some of the programs don’t seem to have
an INI file associated with them.”
James Thompson

A. Under normal circumstances, unless
your application has its own INI file or some
special setting that goes in the win.ini file,
you can't set it up to start maximised. This
is true of applications such as Write and
Paintbrush which open up windowed, and
the size of the windows depends on
resources — if you keep opening windows
one after the other, they will get smaller and
smaller (Fig 1). With applications that have
an INI file, the setting would be
Maximize=1

If you have Visual Basic or some other
Windows programming language, you can
write a little program which will start the
application you want and then maximise it,
using the SENDKEYS command which
sends keystrokes to the application you
have executed.

One megabyte is worth its weight in gold
You've just upgraded your memory to 16,
32, or even 64Mb of RAM and yet you are
still getting messages like “Application
Execution Error”, “Insufficient memory to
run this application”, “Quit one or more
Windows applications and then try again”,
or “Not enough memory available”.

You’re not alone. Low memory is the
root of many computing problems, and in
many circumstances this isn’t due to the
physical memory in your machine.
Unfortunately, when error messages refer to
“memory”, they’re not all alluding to the
same thing. Computer memory is divided
into many different chunks, each with its
own name and its own job to do. And the
most important of these chunks is the first
megabyte; the one in which DOS resides.

When Windows starts a new program (a
task), it creates a task database (a TDB) for
it. This contains vital information such as its
current directory, its instance handle, and
so on. To maintain compatibility with 16-bit
Intel processors and MSDOS, the TDB is

Windows 3.1

The Write stuff

When using Write:

m For a soft hyphen, press Shift + Ctrl + Hyphen (this is useful with the paragraph justify setting).
m To select all, (mark) the entire document, press Ctrl and click between the left margin and

the left edge of the screen. This is far easier than dragging the mouse through pages and

pages of text.

m To edit two documents simultaneously, simply run a second copy of Write while the first is still
running (you can copy and paste between the two, of course).

m To align decimals in tables, check the Decimal box in the Tabs window. To align tables of
money values, set tabs and check the Decimal boxes associated with them.

m To print multiple columns, print once for each column using different indents.

=] Write - WINI706.TXT [=]=
File Edit Find Character Paragraph Document Help

- To edit two docurnents simultaneously, sitnply run a second =
copy of Write while the first is still running (you can copy and
paste between the two, of course)

- To align decimals in tables, check the Decimal box in the Tabs
window. To align tables of money values, set tabs and check the
Decimal boxes associated with them.

- To print multiple colummns, print once for each column using
different indents.

Write - WINIZ705.TXT
File Edit Find Character Paragraph Document Help

Cne of the great things in Windows [ERlRERE eIV EieRes sy gl N or-r=RiLeli)
o pl=pre i) [felnfolaRiel=ninsla= . =cpecially graphics. But this isn't so great when
vou're slowed down by all sorts of obscure optiens. For instance, do voul
Use Paste or Paste Spedial, and what about all the options in the Paste
Spedal dislogue boxe

Well, Paste is paste - simple as that. But the choices you see in the Paste

Spedal dialogue box will depend on the format of the object in the
Page 1 « |

]

Above To edit two documents simultaneously, run Write, twice

Below To align numbers or currency, use the Tabs settings and check the decimals box

= Write - WINS706.TXT [~]
File Edit Find Character Paragraph Document Help

1

[WNE

- To align decimals in tables, check the Decimal box in the Tabs
window. To align tables of money values, set tabs and check the
Decimal boxes associated with them.

2544 33.00 45.32
45.20 0.99 100.46
10.28 0.65  1287.89

*]

AT :

Positions: | b | 2" | " | I | |
Decimal: B . ] . E 1. = [Mil=
FPositions: | | | | I | |
Decimal: (1% [Tl [[l= . i = [[l=

[ ok | | camcel | | Clearan |
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New names for old — a fast rename tip

difficult filenames.

When you rename a file in File Manager, the cursor goes automatically to the To: line in the
Rename dialogue box, and you’re expected to type in the new name. Very often you want the
new name to be something like the old one. If so, you can avoid some re-typing by copying the
old name in the From: line to the To: line. This is especially useful with convoluted or otherwise

Unfortunately, you can’t simply copy the filename by dragging and dropping. But there is a
way around this. Highlight the old name (or part of it), press Ctrl + C, click on the To: line, and
press Ctrl + V. You can then edit the new name in the To: line until you have the name you want.

= Rename

Current Directory: C:AWIN31

From: ||AP5L.EHE

To: |

Cancel |

Iz e
2 =

Use Ctrl+C and Ctrl+V to copy the old name to the new name, then edit it.

created in memory below 1Mb — in fact, in
the 640Kb of conventional memory. This
section of memory on your machine is so
much in demand and so limited, that it
should be treated like gold.

TDBs are not the only block of memory
that may end up below 1Mb. Applications
such as Word for Windows, Microsoft Mail,
Schedule+ and multimedia packages are
examples of applications that put DLL files
into the first megabyte of memory when
loading or performing certain operations. As
Windows loads segments of code, it gives
each segment an attribute which
determines how it will be treated. Segments
are marked, by Windows, as fixed or
moveable. Fixed code is allocated bottom-
up and, as the name indicates, cannot be
relocated. But moveable code can be
moved or discarded to make room for other
segments. If a fixed segment is too big to fit
into the available space, Windows moves
some moveable segments, if necessary, out
of the first megabyte of memory.

If there’s still insufficient room,
discardable segments, which can be
brought in later as required, are discarded.
All this moving and discarding is controlled
by a program called KRNL386.EXE.

An “out of memory” error that you get
when you try to start an application may
happen because fixed segments (precisely
because they’re loaded from the bottom up)
have been loaded in the first megabyte.
They cannot be moved and end up using
space which Windows may require to load
the TDBs.

What'’s the practical answer to all this?

There are several, but in general the idea is
to free as much conventional memory as
possible. You can optimise conventional
memory (with DOS 6 or 6.2) using
MemMaker, and/or you can achieve
satisfactory results by changing the order in
which programs and drivers are loaded. It’s
difficult to give precise advice here and trial
and error is usually the order of the day:
altering the loading order may well affect
where the fixed code gets placed.

Creating a multiple-boot configuration
can also help minimise what loads into
conventional memory for particular
operations — it may free enough space for
Windows to load the TDBs.

Other techniques include:

m Disabling any applications that start
automatically when you start Windows
(check the win.ini file and the Startup
group).

® Running Windows Setup and changing to
standard Windows drivers (VGA, No
Mouse, No Network).

m Using the Program Manager
(PROGMAN.EXE) as your Windows shell.

Finally, for troubleshooting, remove any
third-party Windows drivers or virtual device
drivers (VxDs) by re-marking them using a
semi-colon (;) at the start of the line in the
system.ini file.

If you have any queries or Win3.1-related topics to
discuss, contact Panicos Georghiades and
Gabriel Jacobs at Win3@pcw.vnu.co.uk.
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Starters orders

How to get applications to open on startup, getting stuck in to Paste, and gaining the
upper hand when your computer hangs. With Panicos Georghiades and Gabriel Jacobs.

he usual way of automatically
starting programs when Windows

is loaded is by moving (dragging)
or copying (dragging while pressing down
the Citrl key) all the application icons you
require into the Startup group window. To
automatically start all the applications found
within a particular group, you can change
the name of the Startup group entry in the
progman.ini file. Using Notepad, edit this file
to contain the line
Startup=“group name”
where “group name” (quotation marks are
needed) is any acceptable group in
Windows. For example, to start the
applications in the group Project A (a group
you created, and added in all the programs
you require for a particular project you are
working on), you would add the following
line to the progman.ini file:
Startup="Project A”

Acceptable group names are what’s
listed in the Window menu in Program
Manager or at the title bar of the group you
want to start automatically. Adding the
above line in the Progman.ini disables the
Windows Startup group until the line is
removed or commented out with a semi-
colon (;) at the beginning of the line.

What'’s a bitmap and what’s a picture?
One of the great things in Windows is the
ability to copy and paste from one
application to another, especially graphics.
But this isn’t so great when you're slowed
down by all sorts of obscure options. For
instance, do you use Paste or Paste
Special, and what about all the options in
the Paste Special dialogue box?

Well, Paste is paste — simple as that.
But the choices you see in the Paste

= Program Manager "E A

File Options Window Help

—
|aax aaz Sgs
Ao AFo

Application:

Adaptes SES1 CorlSCS1 2

Main  Accessories Statlp

vﬂ#

= Project A
Lk

bicrozoft
Exzel

e

&
A

@ [l

4
&

FontManger ALLTYPE  Coel CD Office PhotoFiriish

Companion

Wideo for
indoms:

Microzaft
Office

= ntenpai PHI) [ w |

| File Edit

[Settings]

Window=155 188 695 581 1
display.drv=vgakahtx.drv

Order=2 17 8 1 5 1518 4 712 13 6 16 ¢ 3 11 14
Autofrrange=1

Startup="Project A"

Search Help

L[+

[Groups]
Group1=C:\WIN31\PROJA.GRP
Group2=C:3ZWIN31VACCESSOR .GRP
Group3=C:\WIH31\STARTUP .GRP
Group4d=C:\WIH31\ADAPTECS .GRP
Group5=C:\WIN31\UWIDEOFOR .GRP
Groups=C:\WIN31\5PEA.GRP

-w|.u.|

=11 ]

To automatically start all the applications in the group Project A (a group you created, and

added in all the programs you require for a particular project you are working on), you would add

the following line to the progman.ini file:
Startup="Project A”
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= Paste Special

Source: FPaintbrush Picture

00187108

Data Type:

Paste I

Picture

avie Link I

Cancel

Special dialogue box will depend on the
format of the object in the Clipboard. This
can be a bitmap or a Windows metafile
(Microsoft calls this a Picture), and selecting
either of these means that the object is not
part of an OLE (Object Linking and
Embedding) library: it’s a so-called static
object with no links to anything else.

If you select Bitmap from the Paste
Special dialogue box, the object will be
painted more quickly but will take up more
disk space when the file is saved. The
reverse is true of a Picture.

A bitmap file (extension may be BMP,
PCX, TIF, GIF etc.) is a grid filled in with
coloured dots. Its file size depends on its
width and height in pixels and its colour
depth: black and white (1-bit), 256 (8-bit) or
16 million (24-bit) colours. Scaling (resizing)
of bitmaps creates distortions, jaggedness,
and other unwanted effects.

A metafile or picture (the extension is
usually WMF) often consists of a variety of
different data structures (usually scalable
vector graphics, but it can include bitmaps)
and takes up little space. Metafiles can be
scaled, and printed using the highest
resolution of the printer. However, if one of
the data structures includes a bitmap, then
scaling will produce the same kinds of
distortion of the bitmap element as you
would get with an ordinary bitmap.

Try copying a graphic from a paint
program to the Clipboard and pasting it into
another application. You won’t see much
difference whether you choose Bitmap or
Picture in the Paste Special dialogue box.
Now copy a graphic from an application
which normally uses the metafile format
(Excel, say). Do this first by choosing

Bitmap, then Picture, and see the difference.

When in trouble ...
When your computer hangs, or when you
get a message about something being

unrecoverable, giving the machine the three
fingers treatment (Ctrl + Alt + Del) isn’t
always the best choice. Various problems
can cause software to behave badly or
crash, and even make your machine go into
a deep sleep. Some of these problems may
be caused by incompatibilities between
programs, or between programs and
hardware, or between different pieces of
hardware.

Sometimes (although not often) you may
find an answer in the documentation. If not,
you may have to contact a support service.
But when you do, you'll have to tell them
exactly what has happened, and for them to
be able to diagnose the problem, it has to
be one that can be repeated. If it can’t be,
you may have to do a lot of detective work
to find out the cause. Most problems in
computing are solved by a process of
elimination, which means you often have to
make a fresh start. And if your system has
crashed, you will have to do this anyway.

There are three ways to restart a
machine: (a) pressing Ctrl + Alt + Del (the
three-finger method); (b) pressing the Reset
button; and (c) turning the machine off,
waiting for a while, then turning it back on.
Never turn the machine off, then
immediately on, as you risk wrecking your
hard disk.

Which method?

The three-finger method is known as a
warm reboot and in most cases skips the
power-on self test. What's more, it generally
doesn’t reset all the adaptor cards in the
adaptor slots. Using the Reset button (a
cold reboot) usually makes the machine go
through its self test, but doesn’t necessarily
cut power to the motherboard or (once
again) to the adaptor slots. Therefore, to be
sure that everything has been reset from
scratch, you should turn off the power
completely. After about 15 seconds, the

capacitors in the motherboard will have
discharged and the hard disk will have
stopped spinning.

If you use the three-finger method or the
Reset button and the problem isn’t cured,
but it is cured if you turm the machine off
and on, this implies a hardware problem,
usually with a graphics card, internal
modem, sound card or other controller.

One final, important point: If you're using
a write-behind cache, make sure that the
contents of the cache have been saved to
disk before turmning off the machine. You can
do this with smartdrv.exe 4.0 or later by
entering SMARTDRYV /C at the DOS prompt.

Disk dilemma

Christian J. van den Bosch writes: “/ had an
empty 0.5Gb partition on my hard disk, and
| decided to turn it into a compressed
volume so | could copy a CD-ROM into it. |
went into DOS, typed DRVSPACE, chose
the partition, and chose to have 2Mb of
uncompressed space on the drive (this
being the minimum offered), but there were
a number of anomalies. The process took
about half an hour and included at least
three defragment operations using
Scandisk. The result was a 0.5Gb
compressed drive occupying 340Mb of real
space and a claimed compression ratio of
2:1, leaving 160Mb free (not 2Mb as
requested).

“All attempts to enlarge the compressed
drive (reduce the uncompressed space)
were rebutted: apparently, the remaining
160Mb of uncompressed space contained
files that could not be compressed. In the
end | just created a larger partition.

“Can you explain?”

<cjp@homenet.ie>

It’s normal for the process to take a long
time, even half an hour, and normal for the
Scandisk operations to check the disk.
DOS DrvSpace (originally known as
DoubleSpace) does not precisely double
the space on your hard disk. Doubling is an
estimation derived from an average
compression ratio. Different files compress
at different ratios depending on what they
contain. We carried out some experiments
on this, with the results shown (see the next
column).

We can’t explain why you got an
estimate of 2Gb with a compression ratio
of 2:1, except that sometimes the possible
compression is overestimated. In any case,
changing a drive’s estimated compression

Windows 3.1

Utility of the month: SYSEDIT.EXE

Command Line:

If you like playing about with system files — editing your autoexec.bat, config.sys,
win.ini, or the system.ini files — there’s a Windows utility called SysEdit which has
been designed especially for this purpose. SysEdit.exe can be found in the
Windows\System directory (it can’t be run from DOS) and it opens all four files at the same time.
It also creates a backup of the original file with an SYD extension. When booting a system from a
floppy drive, note that SysEdit brings up the autoexec.bat and config.sys files found in the root
directory of your boot hard drive, not the ones on your floppy.

|E:W|I’IH31 WSYSTEMASYSEDIT.ERE Cancel

[ ] Run Minimized

You can run File Edit Search Window

Browse. __

System Configuration Editor -3

DEVICE=C:\DOS{HIMEM.SYS
DOS=HIGH

FILES=100

. = CAAUTOEXEC.BAT | =1l[=] CAWIN3T{WIN.INI [=1=
SysEdit by  [sroMeT spsg +][[windoves] 7y
. . ISET PATH=C:ADOS;CAUTILS;CAWS 4;CAWINZT;CAGWS lspooler=yes m
selecti ng File IREM the next line was Inserted by PIPEX Dial Version 3.0| [|lload=
IPATH %PATHS%;CADIAL\pctcp tllrun=
and Run from IREM the next line was inserted by PIPEX Dial Version 3.0 .'iﬁﬁ'rif,‘.’.i?«ﬂne
rem SET PATH=%PATH3;CACORELDRY BorderWidth=3
Program rem DOS MAUI - CAMAURSETUPSND.EXE /a330 /19 DALT |[(CursorBlinkRate=530
DoubleClickSpeed=452
ISET TEMP=c}A Programs=com exe bat pif
Manager rem MODE CON CODEPAGE PREPARE=((437) C:ADOS\E] ||Documents=
rem MODE CON CODEPAGE SELECT=437 DeviceNotSelectedTimeout=15
KEYB UK,,CA\DOS\KEYBOARD.SYS MransmissionRetryTimeout=145
L llkeyboardDelay=2 L]
< <
| 1 | 2]
= CACONFIG.SYS ~1=1l=1 CAWINIT\SYSTEM.INI =1

Irem DEVICE=CADOS\EMM386.EXE NOEMS X=cc00-ceft fixedfon.fon=vgafix.fon
DEVICE=C:\DOS\SETVER.EXE fonts.fon=vgasys.fon
display.drv=vgadahtx.drv
rem SHELL=C:\DOS{COMMAND.COM C:\DOS} /e1640 fp Ishell=progman.exe
rem device=C:\dos\RAMDRIVE.SYS 2048 512 256 JE mouse.drv=mouse.drv
rem DEVICE=CSBPROJDRWSBPCD.SYS /D:MSCDO01 {P{ |[inetwork.drv=
language.dii=langeng.dil
Irem ADAPTEC lsound.drv=mmsound.drv
DEVICE=C:\SCSNASPI7DOS.SYS D icomm.drv=comm.drv
IDEVICE=C:\SCSNASPIDISK.SYS /D L llkeyboard.drv=keyhoard.drv LI
< <
A1 13 | K IE3|

] »

+|([boon
38Bgrabber=vivga.3gr

loemfants.fon=vgaoem.fon
28Bgrabber=vgacolrx.gr2

FILE TYPE COMPRESSION
RATIO (X:1)

Zip/GIF 1.0

BMP 1-10

ASCI 2%

Excel/Word 2.4

Programs

(EXE, COM) 1.7

*Depends on content and whether it’s
16,256 or 24-bit colour

ratio doesn’t affect how much DrvSpace
actually compresses the files; it changes
only the way DrvSpace estimates the free
space on the compressed drive. However,
having the wrong estimated compression
ratio for your files can cause DrvSpace to
provide inaccurate space estimates to

DOS, which can, in turn, result in problems
when storing files.

Anyway, we don’t recommend the use
of DrvSpace any longer because hard disk
prices have dropped so low. You can buy a
2Gb IDE drive for just over £160, so why
bother with compression? DrvSpace takes
memory from your 640K, it’s slower to
defragment or to check with Scandisk, and
can affect performance in other ways. And
there may be conflicts with other programs.
Our advice is: hard disk compression out,
larger hard disk in.

If you have any queries or Win3.1-related topics to
discuss, contact Panicos Georghiades and
Gabriel Jacobs at Win3@pcw.vnu.co.uk
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The mousetrap

Yes, it’s a good old-fashioned whodunnit: when your mouse trips up while treading the, er,
mat, you can help it get its act together. Panicos Georghiades and Gabriel Jacobs direct.

ith standardisation on Microsoft-

compatible mice, mouse

problems have lessened but
haven’t disappeared. Mice can still fail to

function at all, be too fast, too slow, move in

certain directions and not others, and work
in some programs but not others.

Mouse matters come in threes. There
are three types of mouse: Microsoft,
Microsoft-compatible, and Microsoft non-
compatible; three different ways of
connecting them: via the bus, a PS/2-style
socket, and a serial port; and they can be
used in three types of application:
1. DOS applications, in which case they
usually require a driver loaded in the
config.sys or autoexec.bat files.
2. Windows applications, in which case the
driver is provided by Windows, or a
Windows driver is provided by the mouse
manufacturer.
3. DOS applications running within
Windows.

And, yes, there are three different

Adjusting mouse settings

m Lowering the Sensitivity value in the Mouse
section of Control Panel makes the mouse
movements less jumpy.

m |f the mouse is jumpy in Program Manager
group windows, lower the granularity settings
in the Desktop icon of Control Panel.

m |f you're using the DOS-based mouse
driver mouse.com or mouse.sys version 7.04
or later, add the /Y switch to the end of the
mouse command line

(c:\windows\mouse.com /y)

m Note that erratic mouse movements may
be specific to the application, video card,
machine BIOS, keyboard BIOS, or machine
type you’re using.

When problems strike, are you a man or a mouse? Take valuable advice on failsafe fix-its

causes of mouse problems:

1. Hardware: the mouse isn’t plugged in
properly, it's a bad or unclean mouse,
there’s a bad mouse socket, a bad cable, a
slippery or uneven mouse mat, or the
mouse is connected to the wrong port or
with a wrong or bad adaptor.

2. Bad drivers: an older or incompatible
version is being used.

3. Conflicting software: your mouse driver
may not agree with Windows, or a particular
program, or with some other program
running at the same time like a TSR program,
anti-virus software, or screensaver.

A classic situation is using too many
drivers. Manufacturers provide drivers for
Windows and DOS (and sometimes for
particular DOS programs) and nowadays for
Windows 95. Don’t install them all —

Windows may not run properly if DOS
mouse drivers are also there.

So, if you have a mouse behaving badly,
first check for hardware causes — plug it
into another computer, or plug another
mouse into your computer. Next, establish
that the mouse works in DOS and in
Windows separately. If the mouse doesn’t
work in a DOS application under DOS, it
will not work in that application if you run it
under Windows. Install the DOS drivers
needed in the autoexec.bat and/or
config.sys files, as described in the
mouse’s documentation, and ensure that
all works fine under DOS.

If you have a Microsoft mouse, use
version 8.2 of the driver which comes with
Windows 3.1 and, if necessary, expand
mouse.sy_ and mouse.co_ (they’re on the

p264 [
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Windows disks) to your hard disk as
mouse.sys and mouse.com by using the
EXPAND command at the DOS prompt.
You can test whether all works well using a
DOS program which supports mouse
movements such as Edit. Then disable the
DOS drivers by placing the word REM in
front of the lines referring to them in the
config.sys and autoexec.bat files, and
check the mouse works under Windows.

The Windows mouse drivers are set
using Windows Setup, and they appear in
the system.ini file in the [Boot] section.
Normally there should be a line like
mouse.drv=mouse.drv

To check you have installed the right
Windows driver, exit Windows, change
directory at the DOS prompt to c:\windows,
and type SETUP. If you get a message
saying no mouse has been detected, select
the Microsoft or IBM PS/2 option.

Note that some so-called Microsoft-
compatible mice are more compatible than
others, and you might have to use some
trial and error. In particular, try the drivers
which come with the mouse installation disk
rather than the Microsoft drivers. If all the
above fails, try the following suggestions.

m Search the drive for multiple mouse.drv
files. If you find any, rename them to
something else, except for the one in the
Windows System sub-directory.

m Test the mouse on a different port.

m Check that there’s only one mouse.ini file,
and that the line

MouseType =

in the [Mouse] section of the file points to
the correct port.

m Try running Windows in standard mode. If
all works well, try loading Windows by
typing win /d:x. If all is still okay, add the
following line to the [386Enh] section of
system.ini:

EmmExclude=A000-EFFF

m Finally, if you’re using a mouse that came
with its own drivers, try to borrow a mouse
that uses the driver supplied with Windows.
If that works, contact the manufacturer of
your own mouse.

Out of Africa

“| 'am doing voluntary work in Nigeria, and
have been working on a stock-control and
tracking program using DOS 6.22 and
QBasic (the v4.5 compiler), but the
compiled version of the program gives a
totally incorrect output at the printer — the
numbers are all wrong. Inspecting the code
doesn’t reveal much, as the only difference

lies in an LPRINT statement (to printer) and
a PRINT statement (to screen). There is no
problem with interpreted printed reports or
displayed reports. I've tried two different
printers — no difference. | enclose some
output samples. My big fear is a virus, as
they are rampant here.”

Leigh Bowden, Nigeria

The Microsoft Knowledge Base doesn't list
your problem, but there are a number of
possible causes.

We doubt a virus is the culprit — virus
programmers tend not to target something
as old as QBasic! We assume that you're
not trying to print while running the program
in a DOS session within Windows, as this
doesn’t work with all DOS programs.

The output samples you sent us show
that the text prints fine; only the numbers
are wrong. This obviously implies that the
problem lies in calculations or statements to
do with numeric data only — perhaps a
different set of calculations is being used to
output to the screen than to the printer.
Programmers sometimes attach calculation
statements to PRINT statements, and since
QBasic needs two different statements, one
for the screen and one for the printer, the
set for the printer may contain errors.

Alternatively, it may be that certain
formatting commands used for the printed
output don’t work properly when compiled.
In any case, check you’re using the right
version of the compiler for the version of
QBasic you have, and that you’re setting
the right options for handling numbers for
the compilation. Also, have you checked
the compiler documentation for supported
statements and commands? Some
statements are supported by the interpreter
but not by the compiler.

The write font

A frustrated Bill Reid (mailto:reidw
@nacn.dnet.co.uk) mailed us about being
unable to change the default font in
Windows Write. Each time you start Write,
the default font is Arial: he wants it to be
Times New Roman.

Trying to answer this query has
prompted us to write about a method of
creating templates for Windows Write, to
use for letters, memos, and faxes, a feature
available on all mainstream word processors
but missing from Windows Write.

You can create your own designs and
save them as standard Write documents.
Give them names like letter.wri, memo.wri

A step-by-step guide to creating Write templates

Windows 3.1

and fax.wri. To prevent overwriting the
templates, you have to Save As, not Save,

= Write - FAX.WRI [-]~ . . .
File Edit Find Character Paragraph Document Help and to avoid using Save by m|3take: make
FAX M ESSAG E ij your template files Read Only by changing
their Attributes in the Properties option of
the File menu in File Manager.
TO . To use the templates you open Write,
then use File Open to select a template, or
FROM : . §
you can assign icons to each template so
DATE : you can open them with a double click. To
do this, start Write and the template in one
go by editing Write’s Properties in the File
y menu of Program Manager. In the command
PAGES INCLUDING THIS ONE: . o
line of the Properties dialog box add the
filename of your template, so the command
line reads, for example, write.exe letter.wri.
‘Dem. ____ x Do this for all your templates by clicking
|| and dragging the Write icon while pressing
TR £ the CTRL key to
make copies of
l|=-‘ File Manager |"IA!! . p K
Above Create your templates in Write and save File Disk Iree Yiew Options Window Help it, then editing
them as any ordinary Write documents =] CAWINITY EE each one’s
=l =l [ =d [=e C [PANDC] )
- Clwavepach [+ chold.wav 24962 10/03/92 0310:00 s |*] command line
Right From File Manager make the template files I E1 webputd0 B ding wav 11598 10/03/92 031000  a toinclude a
B3 win31 [2) tadawaw 27804 10/03/92 0310.00 a
Read on|y O meapps sashtwrl G40 07A01/97 024520 a different
£ pistran Iax.wm B40 08/01/97 19:48:00 a
) spstem |2 letterwri 40 D8AT/97 19-33:38 ra template
) ) . . - COwind2app _] mErmo. Wi 640 08/01/97 19:40:00 ra j .
Below Create multiple copies of the Write icon - E1wings Pl | B repottwi B40 DR/N/AT 134010 [ filename.
and edit each one to include the template file El B & E Change the
name in the command line default Write
File N & FAX. WRI .
o i bsies icon to another
Last Change: 08/01/97 19:46:00 one by USiﬂg
5 o C:AWIN31
= Program Item Properties _m ;
- a ibutes - Icons
Description: |fax | | oK i iead Only O Hidden embedded in
lArchive O System
Command Line: WRITE.EXE fax.wri —Ican-:el Progman.exe.
Working Directory: 1 file(s) (640 bytes) [Total 235 filafs) (5,191,148 byies)| To change
the default font

Shortcut Key: |None

| Browsze. .

O Bun Minimized

W2

Change Icon... l

Right You will end up with multiple Write icons,
each one starting a different template

Below To customise your templates even more,
choose a different icon for each one using the
icons embedded in Progman.exe, or any other
icons you may have

from Arial to something else, create an
“empty” template. The only problem is that
the template can’t be completely empty, so

= Program Manager -

|A.

File Options Window Help

you need to
= Program Manager rl&]| teea
File Options Window Help space, say,
+|| thenselect
|| that space
PA PA p” F‘} with the
mouse, and
letter fan memo et from the
Fonts menu
"= change the
e ont to the
font to th
Faintbrush Terrminal Hotepad Recarder E one you
4-{ I | _'!j want.

= Accessories n 2!
& o &
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Al H el |
=
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+
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If you have any queries or Win3.1-related topics to
discuss, contact Panicos Georghiades and
Gabiriel Jacobs at Win3@pcw.vnu.co.uk.
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Double trouble

Windows 3.x programs running under Win95 is not a happy marriage, but don’t despair —
Panicos Georghiades and Gabriel Jacobs explain how you can have the best of both worlds.

he good thing about new

versions of software is that they

are usually better than their older
counterparts. This was undoubtedly the
case with Windows over DOS, as it is with
Windows 95 over Windows 3.x. But we are
talking here about general use rather than
specific applications which, in some cases,
do run better on an older operating system.

The bad points about upgrading to new
versions (apart from the cost) are that newer
software is more likely to have bugs, and
your machine and peripherals may also
need upgrading. There’s also the fact that
not everyone is upgrading overnight; it's a
gradual process sometimes taking years to
complete, by which time an even newer
version is on the way.

It would have been great if, say, on the
24th August 1995, every hardware and
software manufacturer on earth had
Windows 95 versions and drivers available.
We could all have upgraded immediately,
and painlessly. This didn’t happen, of course,
and even a year and a half later, there’s
hardware out there which doesn’t have
Windows 95 drivers, and software which will
never be upgraded to Windows 95.

Microsoft may boast that Windows 95
has sold more copies than Michael
Jackson’s “Thriller”, yet the reality is that the
majority of Windows users have stuck with
3.x (usually 3.1). Many large organisations
have been holding back because they know
that the cost, in time, of solving
incompatibility problems from new software
is often much higher than that of buying the
new software in the first place.

So, if you’re not fascinated by solving
problems, we recommend that you run
Windows 3.x programs under Windows 3.x,

and dedicated Windows 95 native 32-bit
programs under Win95.

We're not saying that Windows 3.x
programs don’t run under 95, but problems
arise with non-Windows 95 drivers for
hardware, old Win95 drivers, and some
program installation procedures. Even if a
Windows 3.x program doesn’t depend on
drivers, its installation procedure, designed
for 3.x, may cause problems under
Windows 95. It may replace files with older
versions, or it may install things like Video
for Windows and other MCI Windows 3.1
code not needed in Win95. It may mess up
your Win95 installation, to a point where
your machine simply will not start.

In general, play safe: you're far better off
running programs on the operating systems
for which they were designed. On the other
hand, Windows 95, like Mount Everest, is
there. So the solution is to have the best of
both worlds. If your machine runs 3.x and is
not up to Windows 95, don’t upgrade it.
Keep it as a Windows 3.x and DOS
machine to run your old software, and put
the money you save towards a new
Windows 95 machine.

If your machine is up to running
Windows 95 and you have a large hard disk
(1Gb or preferably 2Gb as hard disks are
very cheap nowadays), it is possible to keep
your old DOS/Windows 3.x installation as
well as a new Win95 installation, on the
same machine. This is fairly easy to do, and
you can have both working in harmony (but
not simultaneously) provided you watch out
for certain things.

Here’s what you have to do, although
you can only do it with versions of MSDOS
5 or later (see Fig 1 for the technical
reasons why):

m When you install Windows 95 and you
are asked in which directory to install it,
choose a different directory name from the
one that Windows 3.x is using.

If you are starting from scratch (which is
not a bad idea) you can use names like
Win31 and Win95. You will then be warned
that you will have to re-install your
applications — you will have to do that
with your new Windows 95 programs
anyway.

m Go ahead with the Windows 95
installation as normal. Windows 95 will copy
some of your MSDOS files (scandisk,

Fig 1 Boot room

Why can’t you have a double boot (Windows
3.x and Windows 95) with DOS versions
earlier than 5.0?

The answer is that Windows 3.x sits on
top of DOS, and in the earlier versions of
MSDQOS, the first three sectors of the io.sys
file has to be placed in the first three sectors
of the data area of the hard disk. Following
version 5.0, this constraint was removed from
DOS.

When you install Windows 95 on a PC
running DOS 5.0 or later, the setup routine
actually keeps your previous io.sys,
msdos.sys, command.com, autoexec.bat
and config.sys files after renaming them with
a .DOS extension (io.dos, msdos.dos, and so
on).

If you install Windows 95 in a new folder,
the line “BootMulti=1” is automatically added
to msdos.sys, after which you can have a
double-boot configuration. But if you delete
jo.dos, msdos.dos or command.dos, or if
they get damaged in some way, or even if
you simply move them to any other directory
except the root directory of the boot drive,
you can’t boot under DOS, and therefore you
can’t run Windows 3.x.

p274 0
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Copwright Microsoft C_DIruDrst.iﬂn 1994,

defrag, etc) into its own directories and
replace them with batch files (Fig 2, below).
It will also rename some of your DOS
system files (see Fig 1) and will leave your
Windows 3.x installation alone.
m After Windows 95 has been installed,
press the F8 key during boot-up (very
shortly before the message “Starting
Windows 95”). This will give you a menu
with a number of options for starting up.
One of them will be “Start your Previous
Operating System”.

If you select this, your machine will start
as before under your DOS/Windows 3.x
operating system. In other words, you
should be able to run DOS and Windows
3.x as if Windows 95 were not there. The
Windows 95 directory and programs will be

visible on your hard disk, but file and
directory names will be shown in the DOS
eight-characters-plus-three-characters
format (using the ~ character) instead of the
long filenames.

For example, the Windows 95 directory
Program Files will look like this (see also,
Fig 3):

Progra-1

m After the message “Now loading your
previous version of MS-DOS, please wait”,
you may get one of the following error
messages:

Your previous MS-DOS version is not
supported. MS-DOS startup failed.
or, you could get

Your previous MS-DOS files were not
found. MS-DOS startup failed.

MS5-DOS Prompt

NDOS >dir =.hat

Uolume in drive C is PANOC
Uplume Serial Number is 31BA—18E7
Dirvectory of C:\DOS

SCANDISK BAT
DRUSPACE BAT

152 @7-11-95 9:58a
329 @87-11-95 9:58a
DEFRAG BAT 339 A7-11-95 9:50a
DBLSPACE BAT 4683 @7Y-11-95 9:58a
4 fileds? 1223 hytes
175439872 hytes free

C:5\DOE>type scandisk.bat
RECHO OFF
ECHO.

ECHO To »un ScanDisk,. change to the directory containing Windows 95.
ECHO and run SCANDISK from the “COMMAND subdirectory.

If you do receive one of these messages,
you need to check whether the line
BootMulti=1
is present in the msdos.sys file in the root
directory of your boot drive.

m [f itisn’t there, you will have to edit the file
and add that line. But take note that even
though msdos.sys is a text file (and can
thus be edited in Notepad) it is also a read-
only, hidden system file so you’ll need to
change its attributes to modify it. You can

do this in Windows 3.x File Manager, or
Windows 95 Explorer, or by using the
ATTRIB command at the DOS prompt.

Things to watch out for

This multi-boot option requires you to
restart your machine (either a three-fingered
warm reboot with Ctri+Alt+Del, or Reset wil
do) as you can’t switch between one
operating system and another just like that.
And, by the way, make sure Windows 95

Select the drivefs] you want tocheck: forefrons:

B panos
= Panod [[1:]
(=) Remowvable Dizk [E:)

Lel [}

—Tupe of test

=[] |-'-|FJE":

filenarnes.
I | Altamatital i e

Checking tolders...

' Repair the erar
I a Dielete the affected folder
" |gnore this-enor and-conbinue.

Cancel. I

ScanDizk Found an Error on Panoc [C:] ElES
The 'C;\Program Files\AooessorestHuperT eminal folder is damaged,

e fest | This folder containg one or more long filehames that are no lohger
assnciated with files, ScanDisk repairs the enor by deleting these

Fig 4 If you delete files with long names in Windows 3.1 or DOS, you may well encounter

problems when running Windows 95

Microsoft Technet: our productivity product of the month - CAPROGRA™IACCESS V.~ 1] Figs always shuts down properly first.
Eé‘: E: =k — CHRENOC) If you run Most PC manufacturers do not install
. . . = progra” | ] 1B L2 ) , .
Th:re"alzg r;an?/ books, CD_VF\{/Q'ZIS’ vu;eotazes no:ton ly I\éllcr;)sct)ft pr_(r):ucts bu:tsor:?e third- Iil %hyperm T1/25/96  736400m o Windows Windows 95 over MSDOS, so if you have
and all Kinas of courses on WIiNndows s.X an party products, 100. ere are literally aspmet™1 mspainit. exe 311808 741495 9:50:00am a . . .
- ; . : £ cequad™1 Ewodoadess 183296 7/11/95 35000am & 3.1and bought a machine with this standard type of
DOS. However, the richest mine of thousands of articles through which you can £ conior i Wind 95  Wind 95 installati DOS tern i
information is to be found on Technet browse by using either an Explorer or File 9 corsle™1 indows .In ows |r.ls aliation, i systemiies
(Technical Information Network), a Manager tree-type structure, or the built-in g'”tE'”"j1 L onthe will not be on it and you will not be able to
subscription CD-ROM from Microsoft. This search facility. i = same have the dual boot unless you re-install
monthly set of CD-ROMs contains If you are working in a support g th;mic: machine, everything yourself.
specifications, updated drivers, press department, or are simply interested to find = psfn‘:t;m this is how On top of all that, even though you can
releases, lists of problems and their solutions, out about how to get the best from your I £ psfonts | | hare data fi q ’
. . - - + &
as well as hints and tips from the developers system, this is the tops. | = B E the long share cata Ties and even run. some
and technical support people at Microsoft on m See “PCW Contacts” box for details. filenames programs under both operating systems,
E"""' '::P"a F"E‘“‘:“e“""“ will look. there are a few things of which you should
A e .
a giewgniantk lﬂ Help | All Folders | Eonterts of 'C:\Progiam Files\accessaries’ This is be careful.
EEEEREEr LR T Pioman Fies Al Mame | e[ Tpe normal 1. Configuration settings: Programs that
- A Accessories | JHuperT eminal | File Falder s s . " .
‘ Bl it et KD Anplioation keep their configuration (INI) files in the
E Knowledge Base - Win 3.x = Celuadriat P . . .
3 @ Applcation Hotes i g g zszé;"wpc 1?2: efpnlclcsi"::mtens'm Windows directory, rather than their own,
gEnvir:nm;nt‘aFiIConfiguratmn Informmaticn _! | Print Command Shaded in Windows Notepad Carel CD Creator E‘ pcmmpazlit JEKE - FLT File may create two COﬂﬁgUratiOnS and may run
taphics Related lssues Irternet Assistant o . .
gHardwaveHelated\swes = Microsot Evhangs [ | éﬁ;";ﬁ;& e e differently under the two operating systems.
Miscellanscus Refated [nformation The informwation in this article applies to: # Sound Forge . ), .
@ Mulimedia Fielated lssues e A U S S e % (30 The Miciosolt Nitiark Don’t expect the same settings to be
ggitEw:ki:g Fl‘mhlems ey H el T i_;jjf \u"itdzanDafl available to yOu.
echnology i Ehon| . .
. Irteraction with Jrd Party Products R L S R ¢ @0 Psfonts _ﬂ i | L‘ 2. Long filenames: Use Only the e|ght‘
@F‘nntmg\ssues not exist,the Print comwsnd in Notepad is graved, which |70bf90t[3] |762KB [Dick free space: 172ME) e p|us_three format for any data files you

intend to use under DOS and Windows 3.x.
If you re-save or re-name a file (in Win95)
created with a long filename, under
Windows 3.x or DOS the name will be
truncated and your long filename will no
longer be available in your next Windows
95 session.

3. Disk manipulations (the importance of
which cannot be over-emphasised): You
should carry out all disk manipulations —
defragmentation and scandisk operations,
and as many file deletions and clearance
sessions as possible — under Windows 95
instead of 3.x (Fig 4). At the very least, do
not delete files with long filenames in a DOS
or Windows 3.x session.

4. Last but truly not least: Do not use
DOS and 3.1 disk tools (such as old
versions of Norton and other, similar,
programs) if you have Windows 95 in your
machine. You may damage the Windows
95 installation.

m Panicos Georghiades and Gabriel
Jacobs have now taken up the mantle of
Hands On Windows 3.1 from Tim Nott. In
addition to writing his Windows 95 column
as usual, Tim can also be found
presenting Hands On Word Processing.

POW Contacts |

If you have any queries or Win3.1-related topics to
discuss, contact Panicos Georghiades and
Gabriel Jacobs at Win3@pcw.vnu.co.uk.
Microsoft 0345 002000, web address
www.microsoft.com/TechNet/overview.HTM
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Light relief

So farewell then, Tim Nott — but only from the 3.1 column. He’s going to try his hand at
other Hands On highlights, but before he goes he wants to regale you with tales of
shareware known and loved. By the way — did you know he cheats at Solitaire?

y goodness, this recursion thing
M is a popular problem. You may
remember this first saw the light

of day in last November’s column: the
contents of a directory also appear in a sub-
directory, and so on in an endless recursion.

Tony Hill showed how to replicate the
problem with a disk sector editor and said
that Scandisk would fix it. Well, | haven’t
tried this — I might be brave, but I'm not
daft. Paul Harrison had it when, as he said,
“| tried to run a DOS-only program under
Windows” and was “pretty sure” that
Scandisk would fix it, but reinstalled
anyway. James Mackintosh had it doing
something with Linux, Paul Butterwick
blamed it on a faulty motherboard and Ray
Girling on a faulty power supply. Robert
Carrington-Jones encountered it several
years ago on XT machines running DOS 3,
which, he said, “...precludes any Windows
influence and points to something more
fundamental going on with DOS.”

I'll leave the last word to the oddly-
named Satanic Avatar (he seems quite a
nice chap, in fact): “I think it may be related
to a game installation. Lemmings had a
curious pirate security; the HD disk had a
directory n times replicated, which made it
impossible for pirates to copy. | dunno what
your readers have been doing, but...”

Grovel

Several readers have pointed out that the
Windows speaker driver which lets you
play .WAV sounds through the PC speaker
wasn’t on last December’s CD-ROM as
stated. Sorry. It’s such a tiny file it must
have fallen through a crack in the online
continuum. It should be on this month’s
disk in SPEAKER.ZIP (7,848 bytes).

Mah Jongg for Windows

File Help Preferences Backup Special

Tiles Left:

One of my all-time favourite time-wasters

Hands off

Forty-two, besides being the answer to life,
the universe and everything, is also the
number of Hands On Windows 3.x columns
I've written for PCW. In that time we’ve
seen two new versions of Windows and
covered subjects of fearsome technicality
such as DDE, a blow-by-blow guide to the
.INI files, and what the various types of
memory mean and what to do when you
run out of them.

We’ve done worthy things, such as
weeding out redundant files and mastering
the Object Packager. Since last April we've
been dicing with DOS, too. We've also had
a lot of fun customising Windows in ways
the manuals don’t tell you and playing with

= NewSpeak Translator 2

E Canvert text to modern [politically correct] style
|

v2.0
| Copyright [c] 1995
Kevin Solway

Canvert text to old-fashioned style

Transform your prose with Newspeak

various shareware utilities and diversions.
Anyway, I'm moving on — not so much
to pastures new, as to a field not far away.
Business will continue as usual in the
Windows 95 column, but as from next
month you'll find this one in the capable
hands of Panicos Georghiades and Gabriel
p254 [
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Tim’s top twelve favourites

And so, to tips. We've had hundreds over the past three and a half years — both from
my own investigations and your feedback. So here is my all-time favourite dozen.

1. Starting Windows Change the Windows start-up screen by creating a bitmap (no
more than 16 colours or 50Kb) in RLE format — say, newlogo.rle. You’ll need something
better than Paintbrush; Paint Shop Pro does the job well. Make a back-up of WIN.COM,
quit Windows, and from the command prompt in Windows\System type:

copy /b win.cnf+vgalogo.lgo+newlogo.rle c:\windows\win.com

adjusting paths to suit. If you want an easier way, back up the existing VGALOGO.RLE
and save the new file over the original. Use Windows Setup (again from DOS) to change
any aspect of the Windows configuration. This rebuilds WIN.COM, automatically. Now
run Setup again to change it back; the new screen will stay in WIN.COM.

2. Screensavers To run a screensaver on demand, first edit WIN.INI and add “SCR” to
the line PROGRAMS=COM EXE BAT PIF. Then create an icon for the screensaver
module with, for example, the command line “MYSAVER.SCR /s”.

3. What the .DLL? You can often find out more about a system file (like a .DLL, .DRV or
.EXE) from File Manager’s “File/Properties...”. Alt + Enter is the keyboard shortcut.

4. File and Program Managers Once you have the windows and icons arranged the
way you want them, press Alt + Shift + F4 to save the settings. Don’t forget to turn off
“Save settings on exit” to stop this being overwritten.

5. Program Manager You can restrict users of a PC (providing they don’t know this trick)
by editing PROGMAN.INI and adding a [Restrictions] section containing the following:

e EditLevel= 1 — can’t create, delete or rename groups; = 2 — nor program items; = 3 —
as 2, plus can’t edit itemn command line; = 4 — can’t make any change to groups or items.
e NoRun=1 — disables the File/Run... command.

e NoFileMenu=1 — removes the entire “File” menu.

o NoSaveSettings=1 — can’t save settings.

e NoClose=1 — can’t close Program Manager.

6. Control Panel Control Panel can be similarly restricted: add a [don’t load] section
containing the items you want to restrict. For example:

e fonts=1 e desktop=1 e drivers=1

Note that the right-hand side of the equation can be anything you like; “0” or “gerbil” will
work just as well.

7. Screenshots Grab your own. The Print Screen key copies a screen image to the
clipboard. Alt + Print screen copies the current window or dialogue box. You can paste
these into any bitmap program (including Paintbrush) edit, and save them as files.

8. DOS commands For quick help on most DOS commands, type the command
followed by “/?”. For more information type “help command”.

9. Editing System files There’s a little-known utility, called SYSEDIT.EXE, which should
be in your Windows\System directory. It loads AUTOEXEC.BAT, CONFIG.SYS, WIN.INI
and SYSTEM.INI (plus others if you’re mail-enabled) for editing and automatically makes
backups with the .SYD extension.

10. Your Program Manager Silly, but it works. Create an icon for PROGMAN.EXE itself
in a Program Manager (PM) group. In the “Description” box type what you will. Launch it
and you’ll change PM’s title to your chosen description. Stick it in the StartUp group,
and it will be there to greet you when you switch on.

11. Control Panel If you need quick and frequent access to a Control Panel item, cut
out the middle man by creating items in Program Manager. “CONTROL.EXE MAIN.CPL
FONTS” as a command line, for instance, will jump straight to the Fonts section without
loading the rest of Control Panel. For an added touch of class, dig out the relevant icon
by browsing the .CPL file.

12. Fax Modems It’s a pain when you have to close Fax receive standby software to
launch a comms session. And even more of a pain when you forget to launch it again
afterwards? Try setting up two COM ports (say, 2 and 3) from Control Panel/Ports/
Advanced. Set them both to the IRQ and address used by the modem. Point the fax
software at COM2 and the comms software at COM3. It fools my system, anyway.

Jacobs. The
Lennon and
McCartney of
computer
journalism, they
should need no FOR MEDDLERS
introduction to Version311
regular readers of SRR

PCW, but I'm
giving them one anyway as | can’t resist
playing master of ceremonies.

Oh, goodie...

We’ve seen weird and wonderful shareware
and freeware over the past three and a half
years. There was the Windows Non-
Productivity Pack which contained essential
desktop utiliies such as the Virtual Cigarette
and Elvis Detector. There was Bubba, the
picture-based Windows shell for those who
found Microsoft Bob too difficult.

For my final 3.1 column, I've included
something old, something new, and made
an extra special effort to find the ultimate in
bizarre shareware.

First, the old. One of the first diversions |
ever found for Windows 3.0 was Mahjongg,
which | had lost, until today, when |
stumbled across it in a shareware collection.
[t's a patience game based on the
Mahjongg tile set: the object being to match
pairs and remove them from the board. The
tiles are arranged in a complicated pile, and
you can only remove those that have a free
space to the left or right.

It’s quite tricky, very pretty, and has

Department of dishonour

Last month we found out how to cheat at
Hearts. If you think that’s sad, how about
cheating at Solitaire?

m Isn’t it annoying when you’ve elected to
turn over three cards at a time and you find
yourself stuck with that vital card never
making it to the top of the pile. Wouldn’t it be
nice to, just this once, turn over one card
instead of three?

First, make sure no-one is looking.
Second, hold down Shift + Alt + Ctrl as you
click the deck, which will turn over just one
card. Third, wallow in guilt, and if you’ve
never, ever, won a game of Solitaire,
persevere as there’s a surprise in store.

m Oh, and just to complete the set, here’s the
cheat for Minesweeper. Type “xyzzy”. Hold
down Shift as you waft the pointer around.
Watch the top left pixel of the screen — yes,
that’s the whole screen, not the
Minesweeper window. When you’re on a safe
square, it will light up (set your Desktop to a
dark colour to see this better).

Windows 3.1
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convinced it’s a major contribution to Not | | [Preduct Version 2 2

getting any work done. You'll find
MJWIN.ZIP on this month’s cover-mounted Ah, that’s what it is — getting information
CD-ROM. via File Manager’s Properties

A more recent, and considerably weirder
offering, is Kevin Solway’s Newspeak. This
takes input from a plain text-with-linebreaks  using Notepad or Write you will have to
file and gives you the choice of convertingit  put them in manually. The help file (which
either to elegant old English or a politically is actually twice the size of the program)
correct version — or, to use the latter form,  contains several illuminating texts on the
“experientially enhanced” or “culturally subject of political correctness which are
sensitive”. On balance, feeding it bits of this  both controversial and funny — although
very column, | think | preferred the former: | wouldn’t presume to cast doubt on
“Thee’ll needeth something better than the ideas anyone else has had on
Paintbrush — Paint Shop Pro doth the job.  this issue.
Amen!” has a rather fine ring to it that my
usual prose lacks. m As from next month, Panicos

In PC mode, it not only replaces such Georghiades and Gabriel Jacobs will be
howlers in the text as “short” or “animals” writing about Windows 3.1. Tim Nott will
(with “vertically-challenged” and “non- continue to contribute the Windows 95
human beings”) but adds disclaimers such column. And also from next month, you'll
as “Of course, the above is only one of find him writing Hands On Word
many different sides to this question” after Processing, too.
every statement.

Do make sure that the line breaks are
there, as | found Newspeak crashed
without them. Most word processors will
“Save as...” with line breaks but if you're

Tim Nott can be contacted either by post c/o
PCW or by email at win95@pcw.vnu.co.uk
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Multiple mayhem

Multiple configuration options, low level Windows security, and the search for a cure for the
dreaded RDS. All dealt with before Tim Nott posts his Christmas wishes up the chimney.

artin deL.oughery emailed me

from Bahrain (he must be a

devoted reader because PCW
costs more than ten quid there) with a
warning on multiple configurations, as
discussed in my October '96 column.

He writes: “/ stopped using the DOS
multiple configuration option thing aeons
ago. Why? Well, the prime reason is that
once you have set the whole thing up,
would you be likely, thereafter, to never add
another device to your system or do
anything that will not require a
change to either CONFIG or
AUTOEXEC? | think not, and if you

File Yiew Options Search Tools Window Help

Stargazing

“We are all in the gutter, but some of us are looking at the stars.” So wrote Oscar Wilde who,
with remarkable prescience, also coined “Either that wallpaper goes or | do” shortly before his
last and fatal GPF. But | digress.

As star watching seems appropriately seasonal, check out Chris Marriott’s SkyMap on this
month’s cover-mounted CD. Chris, who comes from Culchet in Cheshire, has created a rather
splendid planetarium for Windows. Tap in your latitude and longitude and you’ll see not just
stars in the east, west, south and north, but planets, asteroids, comets and deep sky objects.
It's on the CD-ROM as Skymap.zip, which contains 16-bit and 32-bit versions. It's a 30-day
shareware evaluation version. The full program shows over 250,000 objects.

m Registration costs £29.95 (plus P&P and VAT) from the Thompson Partnership on
01889 564601.

SkyMap - [Horizon Map1]

Ak | »

like your memory to be optimised

+

[o]~]m[E[Elo]s|8]E o] /]&

(as | do) you will find that
MEMMAKER and your nice new
multiple-configuration CONFIG
and AUTOEXEC will not be cheery
bedfellows. Try running
Memmaker with your config and
autoexec setup for multiple
configuration and see what
happens.”

Certainly, he has a point.
However, it should be possible to
run MEMMAKER on each
individual configuration, save the
results as CONFIG and
AUTOEXEC.001, 002, 003 and so
on, and combine the results into a
single, multi-choice CONFIG.SYS
and AUTOEXEC.BAT. That’s not
to say I'd really like to try it, so
point taken. !

Another observation came from |+

T
+

— .= i —

FaorHelp, press F1

Mag: 5.5 |00:00:00 25-Dec-1996

Tim David, who complained that

he couldn’t get more than nine
menu choices, but | think he was just
showing off.

A starry starry night from Chris Marriott’s SkyMap, which is available on the PCW CD-ROM
this month (Skymap.zip)
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Windows 3.1

If at first you don’t succeed — cheat

how to cheat at Hearts.

humiliating to be
consistently

If you’re an honourable and upright citizen, skip this bit. Not to put too fine a point on it, this is

Add ZB=42 to the [hearts] section of WIN.INI. (If you don’t have a [hearts] section, create
one including the square brackets.) Restart Windows. Play Hearts. Hit Ctrl+Alt+Shift+F12 —
borrow some fingers if necessary — and watch as all your opponent’s cards become visible.

But even having done that, | still find | lose — | don’t really mind, but | do find it rather

The Microsoft Hearts Network

trounced by Game Animation Help

someone called
Terri. So if you're in
the same boat,
cheer yourself up
by changing the
default opponent
names (on a non-
networked
machine) by adding
entries for
piname=,
p2name=,
p3name= to the
section as well.

= Notepad - WIN.INI |~

File Edit Search Help

Fagg Lalt

+

[Terminal]
Port=COM3

[Hearts]
fast=8
gamemeister=1
name=Tim

ZB=42
piname=Groucho
p2name=Harpo
p3name=Chico

5 to Groucho.

«[ | -

Above

Cheating at cards...
Left

...and how to do it

Jerking around
On a more positive note, our man in Bahrain
has a rather novel use for CHOICE.COM
(Hands On Windows 3.1, July '96). Being
forced to share a PC with somebody he
uncharitably (but probably justifiably) refers
to as “the jerk”, he first created two
directories, “Hisstuff” and “Mystuff”, and
copied his PROGMAN.INI and *.GRP files
into “Mystuff”. He then created a custom
Program Manager for the jerk, giving more
limited access before copying this set of
PROGMAN.INI and *.GRP to “Hisstuff”.
Using CHOICE with the /N and /T
switches to suppress the prompt and
timeout to a default, AUTOEXEC.BAT would
always copy the jerk’s Program Manager
settings to Windows, unless he pressed a
certain key (but unknown to him) during the
crucial few second’s pause. “It never

mattered” writes Martin, “what he did to his
program groups (lest he should have
learned how) and never mattered whether
‘Save settings on exit’ was turned on, the
jerk always got the same screen every time
he started Windows. Crude, but at that
level, effective security.”

Roger Pearson had a problem with
Program Manager. It could be minimised or
maximised but when restored “...it appears
as just a short title bar, and | cannot change
its size or position from the top left corner of
the screen. | have printed out all the obvious
files but cannot find any differences between
this machine and another.”

This sounds very much as if
PROGMAN.INI has been nobbled. Open it in
Notepad and you should see a section
headed [Settings]. In this will be a key
named Window= followed by five numbers.

The first two give the position, in pixels, of
the top left corner of the window. The next
two give the size, again in pixels, and the
last should be 1 for restored, 2 for
minimised and 3 for maximised. When you
restore Program Manager from either
minimised or maximised, it will return to the
position and size determined by the first four
numbers. If these are unfeasible, you can
get the problem Roger describes.

The simplest solution is to delete the
entire line, or comment it out by putting a
semicolon in front. Program Manager will
then resort to something restored sensibly in
the middle of the screen.

Recursive Syndrome update

A problem that’s proving very popular is the
mysterious Recursive Directory Syndrome
(RDS), as reported in this column in
November. This is where Norman Burnell
reported that the contents of C:\GAMES
was replicated in C\GAMES\GAMES and
SO on ad nauseum.

A Mr (or Ms) Butterwick reported: “/ also
had RDS, along with other things such as
not reading a file that it had just verified as
being saved, files not existing which File
Manager or a DIR reading had shown to be
in perfect condition, and CHKDSK reporting
thousands of lost clusters or cross-linked
files. After numerous checks and tests, it
finally turned out to be a faulty motherboard
— wish I’d thought of that before trashing a
perfectly good hard disk.”

Colin Mower had a similar problem,
although “...it only existed when | tried to
open up my CD-ROM drive in File Manager
when there was no CD in the drive. | would
get thousands of directories reported as
existing on an empty drive! This caused no
problems in the running of Windows or
DOS, until | tried to back up my hard disk.
MSBackup would try and read all of these
‘ghost’ directories, and complain rather
bitterly after about the 200th empty one. |
tried everything to resolve this problem, but
the only way | got out of it was to re-format
my hard disk and start from scratch.”

Chris Paget came up with a way of
reproducing the problem. “All it takes is ten
seconds with Diskedit or an equivalent.
Having run Diskedit, go to the root directory,
pick a sub-directory and change the cluster
number to zero. When you quit, that sub-dir
will now point back to the root, and voilal a
recursive sub-directory, exactly as
described.” Unfortunately, he doesn’t tell us
how to reverse the process. Not having

Windows 3.1

Dear Santa...

And so to my Christmas wish list. Last year, one moan was
directed at multimedia applications which insist you change
screen resolution before running. So hats off to Talking Books and
Broderbund whose children’s titles do this automatically, without
having to restart Windows, and then neatly change it all back on exit — but

only under Windows 95, alas. However, under 3.1 the titles will run without changing resolution.

Likewise, in response to another moan, there’s a refreshing trend for games and
entertainment CD-ROM s to copy nothing but an icon to the hard disk.

Another wish (which made the charts two years running) was that memory prices would
drop in accordance with other PC components such as processors and hard drives. I'm
delighted (well, not that delighted, as | bought all my current memory before the drop) that this
has come true, and after two years of £20-plus, a megabyte of RAM is, at the time of writing,
less than £5 although it seems to be creeping up again.

A third wish that came true (or very nearly so) was for a UK version of Encarta. I've had to
settle for a “World English” edition but this does a great deal to redress the over-emphasis on
US sport, natural history and culture in favour of more important things such as cricket,
nightingales and the Archers. And yes, it runs under both 3.1 and 95, but just to show you can’t
win them all, it installs 4.5-11Mb of files to your hard disk.

Another wish was for a superfast and stable video card. And | think I've found one — a
Matrox Millenium that provides 16.7 million colours in up to 1,280 x 1,024 resolution. It seems
solid as a rock and, something that’s been on my wish list for a long time, lets you change
resolution and screen depth without restarting Windows. And that’s not just 95 but 3.1, too. And
it’s fast. In fact, it’s too fast, as selecting or dragging text in Word is impossible if the startpoint
and endpoint aren’t on-screen at the same time: everything scrolls far faster than | can react.

And so to this year’s wishes...

1. Can | have an option to slow down scrolling in Word 6 (and 7) please, so | can get my
dragging and dropping back under control?

2. Can | ask printer manufacturers to take a rest from developing? | keep reading of colour
inkjets that get ever better and ever cheaper. But just when I’'ve set my heart on replacing my
six-year-old (but still going strong) Star dot-matrix with the latest technological marvel from
Hewlett-Packard (for instance), Epson, Canon or Lexmark — to name but four at random —
move the goal posts. And by the time I’'ve found the definitive best buy from that lot, guess
what? HP has moved them back again.

3. But if I've really got to force a decision, then can | have an HP 690c, please. And could |
possibly have it a bit early so | can produce those amazingly original Christmas cards I’'ve been
meaning to do for the past five years?

4. And while we’re in an artistic vein I'd like one of those dinky little Artpad graphics tablets with
the cordless pen, from Wacom. | had an all-too-brief loan of one and fell deeply in love.

5. Last but not least, a repeat of last year’s wish. Keep developing for Windows 3.1!

Intraduction

o) BEC Empire Service
The Effects of Warld War |
The Postwar Period

i} The Archers
The BEBC had expanded greatly during
the war and the problems of

o) The &rchers recaonstruction were formidable. The
Recent Developments . . television senice restarted in 1946
and became a great success,
especially following the outside
e broadeast of the 1947 wedding of
Historical Sveeches BRI GUNE R
Elizabeth [} and the Duke of
Tumpty- O =0 nEN Edinburgh. On the radio, the Forces
tumpty- The Archers Programme hecame the Light
Programme and in 1546 the Third
tumpty-tum--- Programrme was devised to provide
Microsoft serious music and cultural

programmes. The BBC thus had three
distinctive radio channels alongside
) its regional output frorm Scotland,
true meaning Wales, Morthern Ireland, and its major
of culture centres in England. By 1950, 30 +

discovers the

Diskedit or a spare PC to hand, | managed
to resist the temptation to try this out. This

; Tim Nott can be contacted either by post c/o
Or.]e’ : f?el' wil rur? and run, but hopefully we PCW or by email at timn@cix.compulink.co.uk
might find a solution.
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NE error Of OuUr ways

Tim Nott dives into the murky waters of the UAE, fishes out the most
common error messages and shows how to deal with them.

ome 2,400 years ago, Euripides

proclaimed: “Those the gods

wish to destroy, they first make
mad.” Were he alive today, he’d probably
amend that to “first send error messages”
as he watched the first draft of the Orestes
vanish into digital oblivion as his word
processor collapsed in a Windows GPF. So
here follows a not-entirely-serious look at
the subject of error messages, what they
mean and what to do about them.

The doyen of them all is the UAE: not the
United Arab Emirates but Unrecoverable
Application Error. This is a throwback to
Windows 3.0 days.

The world’s biggest UAE occurred at the
Hippodrome, Leicester Square in January
1991 at the public launch of Excel 3. Some
say it was tempting fate to have the
Microsoft UK managing director, David
Svendsen, wafting through dry ice in a
ballroom at ten o’clock in the morning
before a packed audience of eager
businessmen and women. Others blame
the enormous display screen used for the
ensuing demonstration. In any event, the
presentation team were adequately
prepared and, when the unthinkable
happened, were able to continue the
demonstration on another well-known, and
apparently more stable, software platform.

UAEs could be caused by anything from
errant applications to wallpaper that was
exactly 1,024 X 768 pixels. As Windows 3.0
matured into Windows 3.1, the UAE
matured into the GPF, or General Protection
Fault, that we know and love today. This is
an example of chaos theory in action and
can be caused by anything ranging from an
incorrect hardware setup to the wrong type
of butterfly beating its wings on Mount Fuiji.

+ Ameol32

Q

and will be zhut down.

It the problem persists, contact the program
wendar.

Thiz program haz performed an illegal operation

Fig 1 (left) Funny, it
was working this

morning — but Win95
users get GPFs, too

[ b,

Fig 2 (middle) The

module AMEOLZEZ.EXE at 0137:00431593d.
Begisters:
EaX=00000000 CS5=0137
EEX=00&640000 25=013f
ECH=00&65£d38 DS=013f
EDX=00000003 ES=013f
Evtes at CS5:EIP:

gb 48 14 66 23 cl 30

AMEOLZE caused an inwalid page fault in -

EIP=0043153d EFLGS=00010Z0z
ESP=0055£d422 EEP=0055fe3d
ESI=00000000 FS=Z04f
EDI=00000000 G5=0000

Sb 50 10 66 cl =l 09 65 42 ﬂ

not-very-helpful
message

Fig 3 (bottom) Better,
but it’s probably a
DLL, not the EXE

What it means is that
an application has
written, or attempted
to write, to an area of
memory already in

available.

= Cannot Run Program

File Manager cannot find the specified file [or one of its components].

Make sure the path and filename are correct and that all required libraries are

use by Windows.

A really good GPF
can spread like an
instant plague. Even
if the offending
application is closed,
others will spring
their own GPFs in a merry round of
“Atishoo, atishoo, we all fall down”.

There are two slim hopes. One is to click
the Ignore button if you're given the chance
and hope that the problem goes away for
long enough to allow you to save your work.
You may have to do this several times, so
don’t give up if the error message returns
after the first click.

The other chance is to press Control +
Alt + Del to force a “local reboot”. You'll get
the blue screen of death with instructions to
close the offending application and return to
Windows. Sometimes, this actually works.

®

Application Execution Error

Cannot find file GAOFFICEAEXCELA\EXCEL.EXE [or one of its components). Check to
ensure the path and filename are correct and that all required libraries are available.

Although GPFs still occur under Windows
95 (Fig 1), personal experience has shown
them to be less frequent and you stand a
better chance of recovery.
m “Cannot find the specified file or one of
its components” (Figs 2 & 3) leaves it up to
you to guess which component, as it
probably isn’t going to tell you. The most
likely cause is that a DLL has gone AWOL.
A Dynamic Linked Library is a central
collection of routines that can be accessed
from Windows applications. These cover
everything from File Open/Save dialogues,
OLE to bits needed for all those shareware
p264 [
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| [1].4 I

Visual Basic applications. One tip
here is to try opening the program [ Pattern

specify a wallpaper file that is not in the
.BMP or .RLE format. It can also arise if

Ten top tips

in a different way: try the Program Name:|(None] 2] you've loaded an .EXE file into Notepad, Last month it was Program Manager. This month it’s the tum of File Manager.
M ) the File M d it and tried t it But dn't 1. Hold down the Control key to select multiple files individually.
anager icon, the ) e anaggr = Help I saved | e'm rl? 0O run it. But you wouldn 2. Hold down the Shift key to select everything between two files. (These two tips also work with
.EXE and an associated data file. r Applications == do anything quite so daft, would you? some dialogue boxes: e.g. adding fonts in Control Panel.)
One of these may be kind enough B4 Fast “Alt+Tab" Switching Probably the most common cause is 3. Single click on a drive icon to change the current window to that drive. Double-click to open a

new one. Ctrl + Letter also switches drives.

to mention the missing DLL. Windows running low on resources, like the

[ Screen Saver . 4. Shift le-click . I . .
= “Call to undefined dynalink”. Name: [(None] B 64Kb of memory that stores things such as - Shift + double-click on a directory symbol to open anew window on its contents. ,
Th lication is looking f = = ) trol butt doth 5. Alt + Shift + F4 saves the current arrangement and settings. “Options/Save settings on exit”
evaprl) ication s 100xing Tor a Delay: 2 5] Minutes \_,‘”"{-‘-'w“' ICONS, CONtrol bULons, cursors ana other will override this, so turn it off if you want File Manager to keep your carefully crafted

routine in a DLL.... It’s found the ~Wallpaper ~ lcons odds and ends. arrangement. SSS———————————_—_—_————
DLL (hooray!) but not the routine File: Spacing: Pixels Check the About box from any Help 6. Don’t save settings, B S TP T v v Ty v e -
(bool). Aimost certainly, one of your O Center @ Tile [ whap Title menu. If resources are below 20 percent, either way, with a window || [E5] [¢] EEREEEEE

DLLs has been overwritten with an . - ) trouble is looming (see Figs 7 & 8). When open on a floppy or CD- = Bl B S = [Fal=h____________

. o o Sizing Gnd Curzor Blink Bate ) . ROM drive. Next time you =| E\WORDS\PCWAHANDSON* - [ ] [~ [2][[= GAWINDOWS3.* - [A_] [-1-]
older version. A varlatlc?n on this is Granularity: [0 B | |stow Fast | they get really low, ITrue'II'ype displays in the open it, it will grind away TP C|Em f B g;ﬂ;s?grzl_s_ %
that there are two versions of the Border wiath:  [3 8] | [T I3 system font and things like buttons and for a long time before [ Sees] | St Berin
DLL on your disk and Windows is scroll bars disappear. The obvious antidote realising the drive is IR ot B ettt
finding the older one first. This Fig 4 (above) Mission impossible: this will earn you an is to close some applications: heavyweight empty. = %x:‘;':‘g,p :
happens, for instance, with the “out of memory” error office suites are the prime offenders. 7. Control + F4 closes the Bindecet doc RQeceescorcm 3

. . current window. [2 resorc.gif Dimicrasof.arp 1
However, some applications leak resources [0~ $ncecsh dac PENEEL | |[Dodeptecsgp 1
] o 8. F5 refreshes the Bnomem2gi Dlgames.ap
Fig 5 (left) It could mean and don’t give them all back to the contents of a window. :EmtﬁnZ i Bmgam\\lg.grp 2
3 . . || [5] cantfind. gif netwiark.grp 1
Ineufiic  to run applicat anything, but | made this operating system when closed. Save 9. Shift + F4 tiles 1 %bavkupg;axbk %ﬂaﬂurf-wp
. . . WINNo: ameolini
@ Quit one or more applications, or free up disk space, to increase available memory. one by renaming eVeryTh”’]g and restart Windows. Windows side by side. [ oautes %iﬁﬁj\?ﬂ?d‘zik %\é‘wn";i;;”lm
Th in. . . ’ 1 X . .
on try again calc.exe to talc.exe and A related problem is the black icons 10. If you're looking for a - Dswaps || Bveache gi B et
o file in a large directory e i - S g
ok ] saving it from mentioned in the October column. If you L i ’ e L e - fememn.g) *
click in the right-hand [T BN N = [ CN| [
Notepad... have a high colour depth display and more pane and type the first
- ' i i ‘ M~ 1WGRAFTIV X
Group File Error Fig 6 (left, bottom) than around 16 icons in a Program letter of the filename. The e T T

highlight will cycle
through all the files
starting with that letter.

Manager group, you'll get an Out of
Memory error if you try to add more icons.
A more obscure variation is that you are

Insufficient memory to perform this operation. Quit one or more Vindows
applications and try again.

@ ...and this one means

you’ve got too many Fig 9 This month’s star turn tip is File Manager

icons in high colour

depth low on the first
B640Kb of DOS Fig 7 (left) in AUTOEXEC.BAT, run PIFEDIT, load
Windows 3.1 Dr Watson and Readers’ write memory. Every E§! Program Manager Resources down  DOSPRMPT.PIF and check that it points to
TOOLHELP.DLL. Old versions of Windows e Microsoft Windows for Workgroups to 11 percent the same location. If not, it should normally

Microsorr Yersion 3.11
WINDOWS. Copyright © 1985-1993 Microzoft Corporation

SHELL.DLL, COMMDLG.DLL and the application means troubleis  point to C:\.

Two neat DOS tricks from Steven Nicolaou

various OLE DLLs can also cause this of Nicosia. First, to find out the number of needs a tiny slice on the way... Another possibility, especially if the error
problem. If there are duplicates in lines in a text file, use the FIND command of this, but some message occurs repeatedly, is that the
WINDOWS and WINDOWS\SYSTEM, with the /V and /C switches and a string of are far more This product is icensed to: SHELL command is being used without the
remove the older versions and make sure gibberish. For example: greedy. I've Fig 8 (below) /p switch. This causes COMMAND.COM to
the newer ones are in WINDOWS\SYSTEM. FIND /V /C “zzyyxxyy” found mail and Product Number ...and sure unload itself, given the chance. The /p

fax software to Memory: 29,104 KB Free

System Resources: 11% Free

be particularly comes
so. To get the

m “This application has violated system
integrity and will be shut down”. This
headmasterly pronouncement is the
equivalent of being caught with a packet of
B&H fags behind the bike sheds and
accused of trying to burn the school down.
It’s usually caused by an errant DOS
application, but an interesting variation is
that it can happen if the processing of an

c:\wherever\myfile.txt
This will return the number of lines not
containing “zzyyxxyy” which in most texts
will be all of them. If “zzyyxxyy” is a word .
you use a lot, modify it to suit. lowdown on this
The second is using wildcards in the REN area of memory,
(rename) command. REN ABC?.BAT use Matt
CBA?.BAT will rename ABC1.BAT, Pietrik’s Fix1Mb,
ABC2.BAT and ABCD.BAT (for example) to included on this
CBA1.BAT, CBA2.BAT and CBAD.BAT

month’s cover-

enough, here it switch should follow the path:

SHELL=C:\DOS\COMMAND.COM/p.

= Microsoft Word

® There is insufficient memory. Word cannot display the requested font.

Squeaky speaky

If you're tired of being the only kid on the
block without a sound card, then take
heart. It is possible to use the built-in
speaker on your PC to play .WAV but not

264 * Personal Computer World ® December 1996

MS LAN Manager script takes longer than
the allotted thirty seconds.

There’s nothing you can do but follow
the instructions to save everything else,
restart the PC and run the application from
plain DOS next time. If a Windows
application produces this, it's probably
been at something stronger than B&H
which has corrupted the .EXE, so reinstall.
m “Cannot read from drive X:” Oh dear,
this could mean that your hard/floppy/

CD-ROM drive is up the swanny. Or it could
mean a loose cable. If it happens in a DOS
box, it might just mean that the file
DOSAPP.INI is corrupt. This retains a list of
settings for Windowed DOS sessions: you
can delete it and Windows will recreate it.
= “|nsufficient memory to complete
operation” (or variations) — (Figs 4, 5 & 6).
This one could mean anything. Word for
Windows 2 used it as a default error
message. Control Panel uses it if you try to

mounted CD-

ROM (Fix1mb.zip). It could mean just what it
says, which is that you are out of common-
or-garden global memory. Buy, or at least
clear, some hard disk space and defrag to
create a bigger swap file.

m “Bad or missing command interpreter”
(DOS message). If you get this after quitting
Windows, the chances are you’ve deleted
or corrupted COMMAND.COM. First of all,
you are going to have to reboot from a

floppy system disk. You did make one,
didn’t you? Then, from the A: prompt, type
SYS C: which will restore the DOS system
files, namely COMMAND.COM, I0.SYS and
MSDOS.SYS. Should you get this from a
Windows DOS box (or should a DOS box
refuse to load), it’s possible that
DOSPRMPT.PIF is pointed at the wrong
version of COMMAND.COM. If there’s a
SHELL= line in CONFIG.SYS or COMSPEC

.MID files. Quality will depend on the nature
of the speaker in the PC but it will probably
be more whimper and squeak than Bang
and Olufsen. Look on the CD for
SPEAK.EXE which is a self-extracting file.
It’s old but it works, even in Windows 95.

Tim Nott can be contacted either by post c/o
PCW or by email at timn@cix.compulink.co.uk
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Weird and Windowful

Tim Nott turns agony uncle to tackle a strange DOS problem, smartdrive and vanishing
Windows worries. There are ten top tricks to teach an an old dog, plus two treats on our CD.

orman Burnell wrote from
Cheshire with one of the weirdest

Yirtual Memonry

problems I've heard for a long - Swapfile Settings =

time. Something had gone wrong with a Drive: G: |—|
DOS game (so, nothing new there) on a Size: 20,475 KB
friend’s PC. Using Dosshell revealed a path Type: Permanent

' . Changer >
Vght}h Went. . . . . [ Digk Status el

:\games\games\games\games\games
9 9 9 9 9 Disk Access:  Using BIOS
games\...
and so on, until Dosshell ran out of memory File Access:  [Dnve C: 32-Bit | +]
some 6,000 directories later. Moving to Drive D: 32-Bit 4]
Windows File Manager, it got stranger still: - -
the contents of C:\games\ were a replica of Mew Swapfile Settings
the contents of C:\ as were the contents of )
D : - *

C:\games\games\, C:games\games\ =fve | Helal | _|
games\ and so on. Another directory Type: |Permanent | * |
(C:\mp2\) behgveol in the same bizarre, Space Available: 277.464 KB
recursive, fashion. Maximum Size: 264,272 KB

Norman tried deleting some of the surplus Recommended Size: 59.376 KB
ol|'rector|es. ' Tgo late | realised that ample New Size: 50443 | KB
disk space indlicated the number of files was

not a problem and it was the directory
structure that was haywire. | had already
cautiously (or so | thought) tried deleting one

B4 Use 32-Bit File Access
Cache Size: E KB

of the sub games directories, only to find that
these apparent duplications were the real
thing, hence DOS and Windows were
among those that were no more.”

The vital clue that he’d missed wasn’t
what was going wrong, but what was going
right. If Windows was still loading, then the
damage couldn’t have been too severe. |
searched the Microsoft Knowledge base for
similar reports but unsuccessfully. | can only
guess that there was an error in the disk
directory structure which was responsible
for the problem. Scandisk (or Chkdsk in
earlier versions of MS-DOS) should be able
to fix this automatically. It’s certainly worth a
try before deleting the lot and reinstalling.
As to how it happened, | have no idea, but

Fig 1 You need to set up Windows 3.11 32-bit file access from Control Panel. It isn’t automatic

as ever in the mysterious happenings
stakes, checking with an up-to-date virus
detector is always a good idea.

Get smart...
Roger Caton, of Bradford, writes: “/ have
Windows for Workgroups 3.11 installed, I've
enabled 32-bit file access and I’'m told that |
no longer need Smartdrive. However, the
line CN\WINDOWSN\SMARTDRV.EXE 2048
128 still appears in my AUTOEXEC.BAT file.
Has Windows fouled up?”

Roger is right, but so is Windows. To
explain briefly, Smartdrive is a disk cache.

That is, an area of memory that acts as a
holding area for disk data. If it thinks the
same data is likely to be read again, it stores
it. Memory access is much faster than disk
access, so performance is enhanced.
Similarly, disk writes are held in the cache
until it is “flushed” and all outstanding data
written to disk. With Windows 3.11 came
32-bit file access and VCACHE (Fig 1),
which replaces (and outperforms)
Smartdrive when Windows is running.

The line in Roger’'s AUTOEXEC.BAT
contains two numbers. The first is the size
(in kilobytes) of the cache under DOS. If you

p254 [
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= TaskTool Settings

[® Display the Clock | 118
[X {Hide the TaskT ool | cancel
[ Swap Text on Task Buttons
|1 |:I T askbutton Refrezh Interval [zec]
Word |+ | Modify
File bdanager | |
E 03 Accessones Add Item
Calculatar | Add Folder
Maotepad
Faint Bruzh | Bemove
Wirite
Mutimedia | About.__
= 3 Comms .
l_ Amenl T | Register...
Move Selected: |4 & | | 4= =% | Help

Fig 2 (above) Setting up

Program Manager Help
File Edit Bookmark Help

TaskTool’s cascading start
Qunlentsl Search I Back I History Iﬁlnssaw

menus — just like Windows 95
Fig 3 (right) Default values for Contents for Program Manager Help

Windows Program Manager is atool you can use to easily start applications, and
organize your applications and files inta logical groups.
Tolearn how to use Help, press F1

positioning the Help screen are
defined in the Win.ini file

Fig 4 (below, right) Various How To...
. Arrange Windows and lcons
bugs on the Windows 3.x Change anlcon
Organize Applications and Documents
Cuuit Windows
Check out our cover CD forthe ~ StartanApplication
Switch Between Applications

calculator have been fixed.

new version
Commands

File Menu Commands

Options Menu Commands
Window Menu Commands

use any DOS applications,
especially disk-intensive
items such as databases,
you still need this. The
second figure shows the size

of the cache under Windows,

in this case a modest 128Kb. | — Calculator -]
So why have it at all? The Edit ¥Yiew Help

answer is that VCACHE

doesn’t work on floppy drives 2.001

or CD-ROMs, so you'll find
that even with this small [
cache, floppy access is much

improved. Note that in order IZ

to cache CD-ROMs, the

MSCDEX.EXE entry should ( MR

—

appear before the
SMARTDRV.EXE entry.

Where are they now? part Il
Further to last month’s “DIY”
session on how to find
missing bits of Windows,

Windows 3.1

Ten Program Manager tips

to different working directories.

few groups open as possible.

icons for programs or associated files.

being overwritten when you close down.

room for just one line of text...

Despite the alternatives, the old dog can still get up to a few tricks. Here is my top ten,
collected from various Hands On Windows columns over the last three years.

1. You can change the starting directory of programs. For example if you store Write
documents in C:\data\writings, select the Write icon, go to File/Properties... (or press
Alt+Enter) and enter this path in the Working Directory box. When you Open or Save
As... you'll be in the target directory without having to traipse up and down the tree.

2. Further to the above tip, you can have multiple entries for the same program pointing

3. Icons use Resources — don’t try to install more than 40 items per group and keep as

4. A related problem is that in 16-bit or 24-bit colour the limit decreases drastically.
You'll get “out of memory” errors and solid black squares instead of icons.

5. For keyboard fans, Control + Tab switches between groups, Enter restores a
minimised group or launches an item and the arrow keys move between items.

6. You don’t have to use the icon that comes with the program. Hit the Change Icon
button in File Properties and browse through .EXE and .DLL files. There’s a good range
of spares in Progman.exe and some tailor-made for DOS programs in Moricons.dll.

7. You can drag files from File Manager and drop them into Program Manager to create

8. If you've tidied up Program Manager and want to keep it that way, press Alt + Shift +
F4 to save the current settings. Turn off “Options/Save settings on exit” to stop this

9. You can change the horizontal spacing between icons from Control Panel/Desktop,
but to change the vertical spacing you need to add IconVerticalSpacing=nn to the
[Desktop] section of WIN.INI, where nn is the number of pixels. Setting this to 50 gives

10. ...so from File/Properties.. ., edit the Description of long-winded programs such as
The Universal Widget for Windows version 3.3 to something more succinct.

= Program Item Properties

Description: |"l|'|l"rite

=}
Fal
—

|WRITE.EXE

Command Line:

Cancel

Shortcut Key: |Nune

|
|
Working Directory:  |C:ADATA\WRITINGS |
|

Browse._.

O Bun Minimized

Change lcon._.

il

You can start a program in any directory you choose and change the icon

another component prone to doing a
vanishing act is Windows Help (Fig 3) and
this is usually because it has been moved
off-screen.

The quick and ruthless approach is to
open WIN.INI and delete the [Windows
Help] section entirely. It will be rebuilt with
sensible default values next time you start
up Windows. However, if you really want to
show off, the entry M_WindowPosition,
followed by five figures gives the distance in
pixels from screen left to window left,
screen top to window top, width, height
and a final 0 or 1 to signify windowed or

maximised. The copy, history and
annotation windows have similar entries,
starting with C, H and A.

A dodgy takeaway

As has been reported to this column, the
Windows 3.x calculator is broken for all
values of x. One, purely cosmetic, bug is
that zeroes to the right of the decimal point
don’t appear in real time. Try entering
5.0005 and you'll see what | mean. Nothing
appears after 5.0 until the final digit has
been typed. A rather more serious problem
is that it doesn’t subtract very well: for

example, try 2.01 minus 2.

The good news is that (after four years) it
has been fixed (Fig 4) although | don’t
believe the fixed version ever made it to the
Windows installation disks. Anyway, you
can find it on our cover-mounted CD-ROM,
this month. Newcalc.exe is a self-extracting
file containing the fixed calc.exe a swell as a
readme file.

Called to the bar
From something old to something new.
Well, new to Windows 3.x users anyway.
Another utility on our CD-ROM this month
is TaskTool (Fig 2). Copy Ttool21.exe to a
temporary directory and run it to install. It
consists of a bar that sits at the bottom of
the screen, containing buttons for each
application running, a button to launch
applications from a cascading menu, and a
clock. If all that sounds familiar, yes, it's
almost exactly like the Win95 Taskbar.
There’s some nice attention to detail.
Click on the clock button and the date
pops up, the bar can be set to hide itself,
reappearing when you move the mouse to
the bottom of the screen and there’s even
an option to reverse the text on the buttons,
so you see “Mydoc.wri - Write” instead of
the other way around. This is especially
useful when you have lots of windows open
and the full title is too long for the button.
You can tell the application from its leading
icon, so its name isn’t essential. Unlike
Windows 95, this works with Microsoft
Office. There’s a Run command on the
launcher menu, which, like its 95
counterpart, remembers a list of the most
recently run commands. The launch button
itself is titled Task Tool rather than Start, but
works in a similar way — you can group
programs into folders, rather like Program
Manager groups except that they can be
nested. About the only Windows 95
lookalike features you don’t get is shortcuts
to folders and the recent documents list.
The only faults | could find with it were
that it caused a phantom bar to appear
halfway up the screen (which went away
when windows were resized), would only
show the date in US mm/dd format and
incorrectly reported the title of its own help
file on the buttons. The version on the CD is
a 30-day trial and registration is $19.95.

Tim Nott can be contacted either by post c/o
PCW or by email at timn@cix.compulink.co.uk
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